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DISCLAIMER
Ministry of Agriculture through the Consultant and core reviewers from all relevant stakeholders included the information to provide the contemporary approach about the subject matter. The information contained in the guidelines is obtained from sources believed tested and reliable and are augmented based on practical experiences. While it is believed that the guideline is enriched with professional advice, for it to be successful, needs services of competent professionals from all respective disciplines. It is believed, the guidelines presented herein are sound and to the expected standard. However, we hereby disclaim any liability, loss or risk taken by individuals, groups, or organization who does not act on the information contained herein as appropriate to the specific SSI site condition. 

FORWARD
Ministry of Agriculture, based on the national strategic directions is striving to meet its commitments in which modernizing agriculture is on top of its highest priorities to sustain the rapid, broad-based and fair economic growth and development of the country.  To date, major efforts have been made to remodel several important strategies and national guidelines by its major programs and projects.

While efforts have been made to create access to irrigation water and promoting sustainable irrigation development, several barriers are still hindering the implementation process and the performance of the schemes. The major technical constrains starts from poor planning and identification, study, design, construction, operation, and maintenance. One of the main reasons behind this outstanding challenge, in addition to the capacity limitations, is that SSIPs have been studied and designed using many ad-hoc procedures and technical guidelines developed by various local and international institutions.
 
Despite having several guidelines and manuals developed by different entities such as MoA (IDD)-1986, ESRDF-1997, MoWIE-2002 and JICA/OIDA-2014, still the irrigation professionals follow their own public sources and expertise to fill some important gaps. A number of disparities, constraints and outstanding issues in the study and design procedures, criteria and assumptions have been causing huge variations in all vital aspects of SSI study, design and implementation from region to region and among professionals within the same region and institutions due mainly to the lack of agreed standard technical guidelines. Hence, the SSI Directorate with AGP financial support, led by Generation consultant (GIRDC) and with active involvement of national and regional stakeholders and international development partners, these new and comprehensive national guidelines have been developed.

The SSID guidelines have been developed by addressing all key features in a comprehensive and participatory manner at all levels. The guidelines are believed to be responsive to the prevalent study and design contentious issues; and efforts have been made to make the guidelines simple, flexible and adaptable to almost all regional contexts including concerned partner institution interests. The outlines of the guidelines cover all aspects of irrigation development including project initiation, planning, organizations, site identification and prioritization, feasibility studies and detail designs, contract administration and management, scheme operation, maintenance and management.

Enforceability, standardization, social and environmental safeguard mechanisms are well mainstreamed in the guidelines, hence they shall be used as a guiding framework for engineers and other experts engaged in all SSI development phases. The views and actual procedures of all relevant diverse government bodies, research and higher learning institutions, private companies and development partners has been immensely and thoroughly considered to ensure that all stakeholders are aligned and can work together towards a common goal. Appropriately, the guidelines will be familiarized to the entire stakeholders working in the irrigation development.  Besides, significant number of experts in the corresponding subject matter will be effectively trained nationwide; and the guidelines will be tested practically on actual new and developing projects for due consideration of possible improvement.  Hence, hereinafter, all involved stakeholders including government & non-governmental organizations, development partners, enterprises, institutions, consultants and individuals in Ethiopia have to adhere to these comprehensive national guidelines in all cases and at all level whilst if any overlooked components are found, it should be documented and communicated to MOA to bring them up-to-date. 

Therefore, I congratulate all parties involved in the success of this effort, and urge partners and stakeholders to show a similar level of engagement in the implementation and stick to the guidelines over the coming years.



H.E. Dr. Kaba Urgessa
State Minister, Ministry of Agriculture                                                                         












SMALL SCALE IRRIGATION DEVELOPMENT VISION
 
Transforming agricultural production from its dependence on rain-fed practices by creating reliable irrigation system in which smallholder farmers have access to at least one option of water source to increase production and productivity as well as enhance resilience to climate change and thereby ensure  food security, maintain increasing  income and sustain economic growth.
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[bookmark: _Toc529616568][bookmark: _Toc531353124][bookmark: _Toc531355482][bookmark: _Toc531426950][bookmark: _Toc531430045][bookmark: _Toc531649990]PREFACE
While irrigation development is at the top of the government’s priority agendas as it is key to boost production and improve food security as well as to provide inputs for industrial development. Accordingly, irrigated land in different scales has been aggressively expanding from time to time. To this end, to enhance quality delivery of small-scale irrigation development planning, implementation and management, it has been decided to develop standard SSI guidelines that must be nationally applied. In September 2017 the Ministry of Agriculture (MoA) had entrusted Generation Integrated Rural Development Consultant (GIRDC) to prepare the National Small-scale Irrigation Development Guidelines (SSIGLs).

Preparation of the SSIGLs for enhancing development of irrigated agriculture is recognized as one of the many core initiatives of the MoA to improve its delivery system and achieve the targets in irrigated agriculture and fulfill its mission for improving agricultural productivity and production. The core objective of developing SSIGLs is to summarize present thinking, knowledge and practices to enable irrigation practitioners to properly plan, implement and manage community managed SSI schemes to develop the full irrigation potential in a sustainable manner. 

As the SSIGLs are prepared based on national and international knowledge, experiences and practices, and describe current and recommended practice and set out the national standard guides and procedures for SSI development, they serve as a source of information and provide guidance. Hence, it is believed that the SSIGLs will contribute to ensuring the quality and timely delivery, operation and maintenance of SSI schemes in the country. The SSIGLs attempt to explain and illustrate the important concepts, considerations and procedures in SSI planning, implementation and management; and shall be used as a guiding framework for professionals engaged in SSI development. Illustrative examples from within the country have been added to enable the users understand the contents, methodologies presented in the SSIGLs.

The intended audiences of the SSIGLs are government organizations, NGOs, CSOs and the private sector involved in SSI development. Professionally, the SSIGLs will be beneficial for experienced and junior planners, experts, contractors, consultants, suppliers, investors, operators and managers of SSI schemes. The SSIGLs will also serve as a useful reference for academia and researchers involved and interested in SSI development. The SSIGLs will guide to ensure that; planning, implementation and management of SSI projects is formalized and set procedures and processes to be followed. As the SSIGLs provide information and guides they must be always fully considered and applied by adapting them to the local specific requirements. 

In cognizance with the need for quality SSIGLs, the MoA has duly considered quality assurance and control during preparation of the guidelines. Accordingly, the outlines, contents and scope of the SSIGLs were thoroughly discussed, reviewed and modified by NAWMP members (senior professionals from public, national and international stakeholder) with key stakeholders in many consultative meetings and workshops. Moreover, at each milestone of SSIGL preparation, resource persons from all stakeholders reviewed and confirmed that SSIGLs have met the demands and expectations of users.

Moreover, the Ministry has mobilized resource persons from key Federal, National Regional States level stakeholders and international development partners for review, validation and endorsement of the SSIGLs.  
Several hundreds of experienced professionals (who are very qualified experts in their respective fields) from government institutions, relevant private sector and international development partners have significantly contributed to the preparation of the SSIGLs. They have been involved in all aspects of the development of SSIGLs throughout the preparation process. The preparation process included a number of consultation meetings and workshops: (i) workshop to review  inception report, (ii) workshop on findings of review of existing guidelines/manuals and proposed contents of the SSIGLs, (iii) meetings to review  zero draft SSI GLs, (iv) review workshop on draft SSI GLs, (v) small group review meetings on thematic areas, (vi) small group consultation meetings on its final presentation of  contents and layout, (vii) consultation mini-workshops in the National States on semi-final versions of the SSIGLs, and (viii) final write-shop for the appraisal and approval of the final versions of SSIGLs.

The deliberations, concerns, suggestions and comments received from professionals have been duly considered and incorporated by the GIRD Consultant in the final SSIGLs. 

There are 34 separate guidelines which are categorized into the following five parts concurrent to SSI development phases:

Part-I. Project Initiation, Planning and Organization Guideline which deals with key considerations and procedures on planning and organization of SSI development projects.
Part-II. Site Identification and Prioritization Guideline which treats physical potential identification and prioritization of investment projects. It presents SSI site selection process and prioritization criteria. 
Part-III. Feasibility Study and Detail Design Guidelines for SSID dealing with feasibility study 	and design concepts, approaches, considerations, requirements and procedures in the 	study and design of SSI systems.
Part-IV. Contract Administration and Construction Management Guidelines for SSI development presents the considerations, requirements, and procedures involved in construction of works, 	construction supervision and contract administration. 
Part-V. SSI Scheme Management, Operation and Maintenance Guidelines which covers SSI 	Scheme management and operation. 

Moreover, Tools for Small Scale Irrigation development are also prepared as part of SSIGLs.

It is strongly believed and expected that; the SSIGLs will be quickly applied by all stakeholders involved in SSI development and others as appropriate following the dissemination and familiarization process of the guidelines in order to ensure efficient, productive and sustainable irrigation development.

The SSIGLs are envisioned to be updated by incorporating new technologies and experiences including research findings. Therefore, any suggestions, concerns, recommendations and comments on the SSIGLs are highly appreciated and welcome for future updates as per the attached format below.  Furthermore, despite efforts in making all types of editorial works, there may still errors, which similarly shall be handled in future undated versions.  





[bookmark: _Toc529616569][bookmark: _Toc531353125][bookmark: _Toc531355483][bookmark: _Toc531426951][bookmark: _Toc531430046][bookmark: _Toc531649991]UPDATING AND REVISIONS OF GUIDELINES
The GLs are intended as an up-to-date or a live document enabling revisions, to be updated periodically to incorporate improvements, when and where necessary; may be due to evolving demands, technological changes and changing policies, and regulatory frameworks. Planning, study and design of SSI development interventions is a dynamic process. Advancements in these aspects are necessary to cope up with the changing environment and advancing techniques. Also, based on observation feedbacks and experiences gained during application and implementation of the guidelines, there might be a need to update the requirements, provisions and procedures, as appropriate. Besides, day-by-day, water is becoming more and more valuable. Hence, for efficient water development, utilization and management will have to be designed, planned and constructed with a new set up of mind to keep pace with the changing needs of the time. It may, therefore, be necessary to take up the work of further revision of these GLs. 

This current version of the GLs has particular reference to the prevailing conditions in Ethiopia and reflects the experience gained through activities within the sub-sector during subsequent years. This is the first version of the SSI development GLs. This version shall be used as a starting point for future update, revision and improvement. Future updating and revisions to the GLs are anticipated as part of the process of strengthening the standards for planning, study, design, construction, operation and management SSI development in the country.

Completion of the review and updating of the GLs shall be undertaken in close consultation with the federal and regional irrigation institutions and other stakeholders in the irrigation sub-sector including the contracting and consulting industry.

In summary, significant changes to criteria, procedures or any other relevant issues related to technological changes, new policies or revised laws should be incorporated into the GLs from their date of effectiveness. Other minor changes that will not significantly affect the whole nature of the GLs may be accumulated and made periodically. When changes are made and approved, new page(s) incorporating the revision, together with the revision date, will be issued and inserted into the relevant GL section.

All suggestions to improve the GLs should be made in accordance with the following procedures:

I. Users of the GLs must register on the MOA website: Website: www.moa.gov.et
II. Proposed changes should be outlined on the GLs Change Form and forwarded with a covering letter or email of its need and purpose to the Ministry.
III. Agreed changes will be approved by the Ministry on recommendation from the Small-scale Irrigation Directorate and/or other responsible government body.
IV. The release date of the new version will be notified to all registered users and authorities.

Users are kindly requested to present their concerns, suggestions, recommendations and comments for future updates including any omissions and/or obvious errors by completing the following revisions form and submitting it to the Ministry. The Ministry shall appraise such requests for revision and will determine if an update to the guide is justified and necessary; and when such updates will be published. Revisions may take the form of replacement or additional pages. Upon receipt, revision pages are to be incorporated in the GLs and all superseded pages removed. 

Suggested Revisions Request Form (Official Letter or Email)

To: ---------------------------------------------------------------
From: -----------------------------------------------------------
Date: -----------------------------------------------------------
Description of suggested updates/changes: Include GL code and title, section title and # (heading/subheading #), and page #. 

	GL Code and Title
	Date
	Sections/ Heading/Subheading/ Pages/Table/Figure
	Explanation 
	Comments (proposed change) 

	
	
	
	
	

	
	
	
	
	


Note that be specific and include suggested language if possible and include additional sheets for comments, reference materials, charts or graphics. 
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	Authorized by
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SSIGL 21:  Selected Application Software’s
[bookmark: _Toc531649992]BACKGROUND
Basic software’s like Global Mapper, Google earth, different GIS software’s, DEM are useful in planning and site assessment. Global Mapper is the easiest user interface software used for data management including organizing, generating contours, layout design, generating & exporting profiles, etc. 

Engineering and water management software’s incudes  
Arc GIS and Arc Hydro: This is a very powerful software used for analyzing vector and raster images, studying and delineating the catchment area, generating contours and profiles, mapping the layout, etc.
AutoCAD: This software is used for designing layout, plan and cross sections of irrigation infrastructures, generating profiles, etc.
Z-profile: this software used for generating profiles for which design was done initially on excels.
Eagle Point: This software is a powerful tool for generating contours, designing layout of irrigation infrastructures, design plan and cross sections of irrigation canals and structures, etc. 
Geoslope/Geo studio is mainly used for stability analysis
CLIMWAT 2, LocClim 1.0, CROPWAT 8, are used  in analysis of climate input data and  water requirement of irrigated crops 
MS Project and Primavera are used for scheduling and controlling study and design as well as construction activities of SSIP
Other software’s like SWAT, Water Cad, SAP, SMADA, Hydrochan are also in SSID 
Software’s used in geology, Engineering geology & hydrogeology are: Geo studio (including all integrated tools like Slope//w, SEEP/W, SIGMA/W, Quake/W) and other geotechnical software’s like Starter, Stero plot. Auto cad is also equally important for the geologists to prepare the sections.  

Software’s used in Topo surveying are: are AutoCAD, Arc GIS; Global Mapper, Auto Cad, Golden Software (Surfer), Stereo net, Strata for data compilation and topo mapping. 

Software’s used in Socioeconomics are;   SPSS16 and SPSS 20, STATA 

We will discuss here in this specific Guideline selected software’s. The other application software’s will be discussed in respective subjects of the Guidelines. 




[bookmark: _Toc531649993]MANUAL FOR EAGLE POINT
[bookmark: _Toc531649994]basic knowledge of eagle point
[bookmark: _Toc531649995]The eagle point software suite
Eagle Point software is the most powerful, yet easy-to-use, civil engineering, surveying and landscape design software’s available. By combining the power of AutoCAD the software employs methods identical to conventional methods used in hand calculations.

The software it is not intended to replace the presence of qualified surveyor, designer or drafting personnel. Instead, the software enlarges the capabilities of qualified professionals. Therefore; a solid working knowledge on the principles of Surveying, Hydrology, Road, Civil and Water Engineering expected by the user.
[bookmark: _Toc426967278][bookmark: _Toc531649996]Purpose
Eagle Point is application software that is used to aid most of Land Development problem including: 
Watershed Modeling
Road Design
Storm and Sanitary Sewer Analysis
Landscape Design
Pressurized Irrigation Design 
Site Planning, Design and Analysis
Intersection Design
Quantity takeoff and so on…
[bookmark: _Toc531649997]Scope
This guideline covers the basic procedures for Surface Modeling, Roadcalc for irrigation design and Drafting (Case study of Petu SSI Project).
[bookmark: _Toc531649998]Computer requirements
Pentium III with Microsoft, Windows 2000 and above, (recommended: Intel processor with 1GB of RAM), 1024x768 display. AUTOCAD software Version 2000-2007
[bookmark: _Toc531649999]case study for petu surface modeling
[bookmark: _Toc531650000]Preparation of working environment
This practical exercise will help how to prepare topographical map using Eagle point surface model package for Petu SSIP.
[bookmark: _Toc531650001]Getting started
[bookmark: _Toc431234472][bookmark: _Toc431242213]Defining a project
Create project folder anywhere and Name it PETU SSIP
Create two folders within it and name them as Data, Plot
[image: ]
Open new AutoCAD file and save it in your project folder as PETU SSIP
[image: ]
Run the program from start menu and the following dialogue will box popup
[image: ]
Click on the Create New Project
Click next by selecting eagle point project
[image: ]
In the project description edit box fill it as Petu SSIP
In project drawing edit box and click open the previously saved AUTO CAD file
[image: ]
Select Eagle point Meters default from the prototype setting drop list
Click on the Advanced tab and select Data and Plot folders for the respective dialogue
[image: ]
Click finish button and Click ok
Eagle point software then launches AutoCAD
The Eagle point software menu bar displays as follows
[image: ]
[bookmark: _Toc531650002]Project setting
I. Units
Select units from the system pull down menu to display the unit’s dialog box. Units are going to be set for the project are adjusted as follows
a) Angular
Select angular from the category drop list
For both input and output make sure that degree, minutes, seconds are selected
Clicks Apply and OK
[image: ]
b) Degree of curvature
Select degree of curvature from the category dropdown list
Select Arc definition from the input/output drop list
Type 20 in the arc definition from the input /output list
Clicks Apply and OK
[image: ]
c) Linear
Select linear from the category drop list in the unit’s dialog box
[image: ]
d) Plan metric area
Select plan metric Area from the category drop list.
Select both input/output and make sure square meters are selected 
Click Ok to save the changed
[image: ]
II. Formats
Select Formats from the system menu to display the formats dialog box
a) Stationing
Select stationing from the category drop list in the format dialog box
Select +000 from the format drop list
Clicks Apply and OK
[image: ]
b) Horizontal Direction
Select horizontal direction from the category drop list in the format dialog box.
Select North Azimuth from the format drop list
Clicks Apply and OK
c) Nodes
Select nodes from the category drop list in the formatted dialog box.
Select Alpha Numeric from the ID format drop list.
Make sure point protection * is toggled on.
Clicks Apply and OK
[image: ]
III. Precision
Select precision from the system menu and keep default values
a) Angular
Select angular from the category drop list
Slide decimal slider to 4.
Select nearest second form Degree, Minutes, Second drop list
Click apply
[image: ]
b) Linear
· Select linear from the category drop list
· Click apply to accept the default value of 3 decimal places.
· Select also plan metric area, dry volume, wet volume, station offset consequently and apply the default value of 3 decimal places precision respectively.
[image: ]
IV. Scales
From the Eagle point menu bar, select tools‐plot scales
Type 1000 in the horizontal scale field
Type 100 in the vertical scale field
Click OK 
[image: ]
V. CAD settings
Eagle point provides a tool whereby you can set default CAD parameters for the majority of
CAD objects that are constructed by eagle point.
a) Default CAD settings
Select system –Default CAD settings.
Highlight the Surface Modeling and then Index Contours entry
Type the size and select the color of the line (index contours) you wish to display in CAD entry.
Type the size and select the color of the line (intermediate contours) you wish to display in CAD entry
Click on OK 
[image: ]
[bookmark: _Toc531650003]Surface Modeling
Surface modeling is a one of eagle point package that models the surface you are working on by performing different manipulation of the raw data from survey, DEM and DTM by creating three dimensional grid formations on the terrain.
Surface Modeling also allows users to create a model from topographical information such as points, break lines or contours. From this surface model, you can create contours, annotate contours, create rectangular grids and place spot elevations.
[bookmark: _Toc531650004]Setting up a surface model
Creating and defining a new surface model, requires the following procedures 
In eagle point, select Products‐Surface modeling
[image: ]
In surface modeling, select prepare‐manage surface models
[image: ]
[image: ]
Click on the new surface model icon then the new surface model dialog box displays 
[image: ]
Type Petu ground model in the description edit filed.
Minimum elevation from Surveying data is 1355.551
Maximum elevation from Surveying data is 1476.524
[image: ]
Click on the CAD setting icon, the CAD setting dialog box displays.
Layer ‐TIN
Color - by layer
Click Ok
Click on apply in the new surface model dialog box and then OK
Click Contour setting Tab icon.
[image: ]
Intermediate Interval = 1
Index Interval = 5
Smoothing Factor = 3
Set the remaining values of the setting as:
Index contours
· Layer IDX‐contours
· Color 9
· Line type by layer
· Width 0
Intermediate contours
· Layer contours
· Color 8
· Line type by layer
· Width 0
Click on apply in the new surface model dialog box.
Keep the rest as default.
Click apply and OK
Click close
[bookmark: _Toc531650005]Importing Survey Data
Survey data’s can be imported from an excel file, an instrument, global mapper, GPS, etc as eagle point have different option to import the data. For this training purpose, you are going to import the survey data from an excel file which is saved in CSV file format.	
Open excel (Survey Data.CSV) and view your data down loaded from a total station. The survey consists of information with point#, Easting, Northing, Elevation and description.

[image: ]
In eagle point, surface modeling‐ select Prepare‐Import ASII‐points
Browse the survey file to the location you have saved
Click on the open bottom
Check the button point#, N, E, description (point code)
Click on apply in the import ASCII point dialog box 
Click on close
[image: ]
Type Z in the command line then e to view the imported data





[image: ]
[bookmark: _Toc531650006]Creating model boundary
Draw a boundary around the data and then predefine it for use in the surface model. To create a predefined boundary for the surface model,
In Auto CAD, create a layer called Boundary line and make it current
[image: ]
Select the poly line command.
Draw the boundary around your data
[image: ]
In surface modeling, select Prepare‐Predefined boundaries command
[image: ]
Click on the new predefined boundary icon.
Pick the boundary object you drew earlier
Type Survey Data boundary in the description edit field
Select Petu ground model from the surface model drop list
Click ok and close
[image: ]
[bookmark: _Toc531650007]Triangulate a surface model
In surface modeling, select triangulate‐surface model	
Select ground model from the surface model drop list
[image: ]
Select predefined from the boundary drop list
[image: ]
Make sure the display selected objects details and Place Triangles are toggled on
Click on apply in the triangulate surface model then close
Select the area to be triangulated by selecting the bounded data in the CAD graphic
[image: ]
Click Ok display selected objects details to proceed triangulation
The result of Triangulation should look like this
[image: ]
In surface modeling, select Prepare‐Manage surface model.
Click on the properties for surface model icon. The surface model properties dialog displays a variety of information for the model as follows.
Click on close
[image: ]
[bookmark: _Toc531650008]Creating contours
In Surface modeling, on contours tab select Make intermediate and index 


[image: ]



Make sure the Petu ground model is selected from the surface model drop list.
Toggle on only User defined boundary 
[image: ]
Click on apply on the make intermediate and index contours in the CAD graphic
Select the boundary you have prepared earlier
Eagle point will execute the process
[image: ]
The processed contour should look like this
[image: ]


[bookmark: _Toc531650009]Annotating contours
Contour annotation is a process that is used label each contour and makes the user to easily recognize the terrain types in CAD graphic.
In surface modeling select Contours‐ Annotate	
[image: ]
Make sure the Petu Ground Model is selected
[image: ]
Make the index toggle on 
Select the Interval option in the method sections
Interval = 500
Click on the Annotation setting button.
[image: ]
Make sure middle is selected from the annotation drop list.
Toggle on Place Symbol Around Annotation
Toggle off the other option.
Click on OK
Click on apply in the annotate contours dialog box.
Select the contour to annotate in CAD graphics
Click on close.
The result should look like this
[image: ]
Zoom into the area that was annotated to view the contour elevation.

[image: ]
[bookmark: _Toc531650010]canal profile extraction from irrigation system layout 
In surface Modeling we have modeled the topographical features of the area of our interest (Topo of the Gross command area). Canal alignment and other important tasks are worked on the surface model as practical implementation of our canal design on the real ground. Precise representation of the ground is imperative prior to any design activity.

Designing an irrigation Canal is to be initiated by selecting the centreline of the alignment using the surface model created. The RoadCalc package found in Eagle point Product menu will be utilized to facilitate canal design. 
[bookmark: _Toc531650011]Getting started
Roadcalc is the step to be started after you have successfully prepared the surface model and the step to be followed to initiate the launch RoadCalc is as follows.
1 [bookmark: _Toc472601681][bookmark: _Toc472627040][bookmark: _Toc480286777][bookmark: _Toc480287311][bookmark: _Toc480287413][bookmark: _Toc480287722][bookmark: _Toc480287864][bookmark: _Toc480288023][bookmark: _Toc480293201][bookmark: _Toc480293304][bookmark: _Toc480293407][bookmark: _Toc480295104][bookmark: _Toc502394097][bookmark: _Toc524454481][bookmark: _Toc524463985][bookmark: _Toc531440536][bookmark: _Toc531440970][bookmark: _Toc531860431][bookmark: _Toc532555510][bookmark: _Toc531650012]
2 [bookmark: _Toc472601682][bookmark: _Toc472627041][bookmark: _Toc480286778][bookmark: _Toc480287312][bookmark: _Toc480287414][bookmark: _Toc480287723][bookmark: _Toc480287865][bookmark: _Toc480288024][bookmark: _Toc480293202][bookmark: _Toc480293305][bookmark: _Toc480293408][bookmark: _Toc480295105][bookmark: _Toc502394098][bookmark: _Toc524454482][bookmark: _Toc524463986][bookmark: _Toc531440537][bookmark: _Toc531440971][bookmark: _Toc531860432][bookmark: _Toc532555511][bookmark: _Toc531650013]
3 [bookmark: _Toc472601683][bookmark: _Toc472627042][bookmark: _Toc480286779][bookmark: _Toc480287313][bookmark: _Toc480287415][bookmark: _Toc480287724][bookmark: _Toc480287866][bookmark: _Toc480288025][bookmark: _Toc480293203][bookmark: _Toc480293306][bookmark: _Toc480293409][bookmark: _Toc480295106][bookmark: _Toc502394099][bookmark: _Toc524454483][bookmark: _Toc524463987][bookmark: _Toc531440538][bookmark: _Toc531440972][bookmark: _Toc531860433][bookmark: _Toc532555512][bookmark: _Toc531650014]
3.1 [bookmark: _Toc472601684][bookmark: _Toc472627043][bookmark: _Toc480286780][bookmark: _Toc480287314][bookmark: _Toc480287416][bookmark: _Toc480287725][bookmark: _Toc480287867][bookmark: _Toc480288026][bookmark: _Toc480293204][bookmark: _Toc480293307][bookmark: _Toc480293410][bookmark: _Toc480295107][bookmark: _Toc502394100][bookmark: _Toc524454484][bookmark: _Toc524463988][bookmark: _Toc531440539][bookmark: _Toc531440973][bookmark: _Toc531860434][bookmark: _Toc532555513][bookmark: _Toc531650015]
[bookmark: _Toc531650016]Creating a roadcalc subproject
In eagle point Select File‐New
Select Roadcalc subproject from the list box
[image: ]
Click on next
Type MC in the project number edit field
Type Main Canal Design in the description edit field
Select RoadCalc metric defaults from the subproject prototype drop list
Click on Next
[image: ]
Select Petu SSIP from the project list box
Click on Finish
[image: ]
To launch Roadcalc, select the Main Irrigation design project and click OK
[image: ]
The Roadcalc menu displays
[image: ]
[bookmark: _Toc531650017]Canal alignment & profile
Eagle point software facilitates to view original ground profiles so that we can export it to excel to design Top bank, Full supply and Bed levels of a canal.
So the design profile of our canal alignment is to be created as allows
[image: ]
The green line is the main canal route selected during irrigation system layout so we start by making alignment using it
From Alignment tab select Convert Objects to Alignment
[image: ]
From the CAD graphics you will be asked to select the object
[image: ]
Left Click on the main canal line and press enter
Inquiry box will pop up to establish the direction of the alignment 
[image: ]
Click on the station that is going to be the beginning 0+000
[image: ]
Keep the default values if it suite you then click Apply
[image: ]
The green line will change red color indicating the conversion is successful
[image: ]
Go to profile tab and select Extract from Surface Model
[image: ]
Select centerline for Profile Name & Petu ground model from drop down list, then Ok
[image: ]
Again you will be asked to select the object in command line of CAD 

[image: ]
Left click and RoadCalc will draw the canal Profile 



[image: ]
In order to extract X, Y and Elevation values we have to prepare black notepad file so the results can be printed on it. To do so
Create Notepad file, name it as MC-Profile, Save it in a place which suites you
Go to file menu and select Print Setup
[image: ]
Select the MC-profile.txt file by clicking the folder icon placed at top right hand side and leave the rest as default
[image: ]
Now go to output tab of RoadCalc and select Station and Coordinates


[image: ]
Make sure for both Alignment and profile centerline is selected
Enter 25.0 at Station interval
Toggled on include Curve Stations only
Click Clear List and After that click Calculate
[image: ]
Finally, to export the data into the note pad file we have previously saved click the printer Station icon
Open the note pad file and view the output file. Utilizing this file, you can design the canal using the canal design template.
[image: ]
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[bookmark: _Toc531650018]drafting cad graphics
Drafting one of eagle point package that provides access to Eagle Point Dynamic Annotation and associates text with objects. With this attachment, objects may be modified and the associated text is automatically updated to match the modified object. In this section you will cover Annotate alignment stationing and Draw a coordinate grid.
[bookmark: _Toc531650019]Annotate alignment stationing
In eagle point, select Drafting
[image: ]
Click Annotate and select Alignment Stationing
[image: ]
Click on the Pick in CAD icon to select the Main Canal
[image: ]
The Begin and End Station Range is filled in with the starting and ending stations automatically
[image: ]
Click on Apply to annotate the alignment stationing
The result should look like this
[image: ]
[bookmark: _Toc531650020]Draw a coordinate grid
The Insert Coordinate Grid command allows you to place ticks, lines or both ticks and lines into your CAD graphic at a specified interval.
To insert a coordinate grid into your CAD graphic, complete the following steps:
Click Insert tab and select Coordinate Grid
[image: ]
Select Placement options as Ticks & Lines from drop list
[image: ]
Northing (Y) interval =100
Lable Interval =100
Easting (X) interval =100
Lable Interval =100
Leave the rest as default 
Click on the Insert button to insert the coordinate grid
Graphically select the location for the lower left corner of the coordinate grid
Graphically select the location for the upper right corner of the coordinate grid
The result should look like this
[image: ]
[bookmark: _Toc531650021]Insert north arrow
The Insert North Arrow command allows you to place a North arrow into your CAD graphic.
Click Insert tab and North Arrow
Enter the scale factor for the North arrow =5
Click on the Insert button to insert the North arrow
Drafting prompts you to select a location for the North arrow.
Graphically select the location at which you want the North Arrow placed
[image: ]
You are done!!!



	
[bookmark: _Toc531650022]MANNUAL FOR HEC-RAS
[bookmark: _Toc470401275][bookmark: _Toc531650023]basic knowledge of hec-ras
[bookmark: _Toc470401276][bookmark: _Toc531650024]The Hec-Ras software suite
The Hydrologic Engineering Center River Analysis System (HEC-RAS) is intended for calculating water surface profiles for steady gradually varied flow in nature or man-made channels.
HEC-RAS is an integrated system of software, designed for interactive use in a multi-tasking, multi-user network environment. The system is comprised of a graphical user interface (GUI), separate hydraulic analysis components, data storage and management capabilities, graphics and reporting facilities.
The HEC-RAS system ultimately contain three one-dimensional hydraulic analysis components for: (1) steady flow water surface profile computations; (2) unsteady flow simulation; and (3) movable boundary sediment transport computations.
[bookmark: _Toc470401277][bookmark: _Toc531650025]Purpose
HEC-RAS is application software that is used to model almost any Hydraulic model problem including: 
River Hydraulic Analysis and its inline structures
Storage areas
Irrigation Canals and its Structures
Time series and elevation controlled gates
Unsteady floodway analyses
Dam break analyses and levee breaching 
Pump stations and navigation dams 
Sediment transport capacity
Other Advantage of HEC-RAS
Useful tables, graphs, and cross-section and profile plots for viewing results
Animation of simulations
Detailed Investigations and alternative evaluations
Design Studies
Real-time forecasting
[bookmark: _Toc470401278][bookmark: _Toc531650026]Scope
This guideline covers the basic procedures for Diversion weir, Irrigation canal and selected Irrigation canal structures Modeling (Case study of Petu SSI Project).
[bookmark: _Toc470401279][bookmark: _Toc531650027]Computer requirements
Pentium III with Microsoft, Windows XP, Vista or Windows 7, (recommended: Intel dual-core processor with 1GB of RAM), 1024x768 display (recommended: 1280x1024 or higher).
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[bookmark: _Toc470401280][bookmark: _Toc531650028]case study for petu diversion weir modeling
[bookmark: _Toc470401281][bookmark: _Toc531650029]Preparation of working environment
This practical exercise will help how to model diversion weir using head work for Petu SSIP.
[bookmark: _Toc470401282][bookmark: _Toc531650030]Getting started
Defining a project
Find the HEC-RAS folder in the Start Menu and click on HEC-RAS to start the program
[image: ]
Select New Project from the File pull down menu in the main HEC-RAS window
[image: ]

Select a drive, and select a path by double clicking in the directory box of the New Project window. For this example, double click on the data subdirectory for c:\Petu Diversion Weir folder\ Enter a title Petu Diversion Weir and the filename is Petu Diversion Weir.prj Click OK 

[image: ]

The English System of units is the default. To use the Metric System, select Unit System from the Options pull down menu in the main HEC-RAS window to change from the English System to the Metric System.
[image: ]
[bookmark: _Toc470401283][bookmark: _Toc531650031]Incorporation cross sectional data
Select Geometric data from the Edit pull down menu in the main HEC-RAS window
[image: ]
In the Geometric Data window, click on the River Reach tool with the mouse and draw the following river schematic by clicking the left mouse button and dragging the reach in the direction of the flow. 
[image: ]
Double-click the mouse to end the reach. Give each reach a name Petu-Shashaf River. 
[image: ]
Click on the Cross Section tool on the left side of the Geometric Data window
[image: ]

Select Add a new Cross Section from the Options pull down menu in the Cross Section Data window and enter the river station label. HEC-RAS requires that river cross-sections be entered starting upstream using the highest number as a "river station" label and proceeding downstream in the direction of flow
[image: ]

Enter data provided below for the Upstream reach (Reach 5)
Downstream reach length = 100 
Manning’s Value = 0.035
Main channel reach station, Left bank =0.00 and Right Bank = 56.38
Contraction coefficients = 0.1 and Expansion coefficients =0.3
	Reach = 5 D/S Reach length=100

	U/S Weir Axis

	Station
	Elevation

	0.00
	1434.482

	5.00
	1434.312

	6.00
	1434.237

	11.01
	1434.100

	13.01
	1433.796

	18.01
	1433.359

	21.01
	1433.196

	24.20
	1432.882

	28.20
	1432.874

	29.26
	1433.034

	34.26
	1433.839

	36.59
	1434.885

	42.59
	1435.876

	47.59
	1437.896

	54.59
	1439.877

	56.38
	1440.479


[image: ]

Subsequent station lengths are all measured from the first station. Enter the corresponding elevations for each station.
The last station is on the right of the river valley, above the main channel and flow area.
Click on Apply Data to accept entry for this cross-section. 
Select Plot Cross Section from the Plot pull down menu to visually check cross-section for errors.

[image: ]

Repeat the above Steps until all river stations for the reach (from reach-4 up to reach-1) are entered (Data provided in excel sheet provided). Then, change the Reach using the Reach pull-down menu and enter data for the rest of the reaches. Press the apply data button after each cross section is entered. 
After all the cross section data is entered, select Exit Cross Section Editor from the Exit pull down menu in the Cross Section Data window
Your main geometry menu should now look like this

[image: ]
[bookmark: _Toc470401284][bookmark: _Toc531650032]Incorporating weir into a HEC-RAS analysis
Hec-Ras requires two cross section u/s and d/s of weir structure located at reach-4, to do so
Click tools in geometric data and select XS interpolation
[image: ]
Click in interpolation and for max distance between XS’s insert 20
In Reach drop down menu select All Reach
Click interpolate Xs’s
[image: ]

Click Tables in geometric data and select Manning’s n or K value
[image: ]

Click and select tabs n#1, n#2 and n#3
[image: ]

Click Set Values and insert value = 0.035 
[image: ]
Click Ok and make sure all cross sections have manning’s value entered 
[image: ]
Your main geometry menu should now look like this
[image: ]
Click inline structure located at the left side of toolbar
File menu select save as and give it a name Petu Dw
[image: ]

Right click and select zoom to the area around reach 4
Click option menu and select add inline structure
[image: ]
Enter value of 4.1 (in which the Weir is located) for the dialogue “enter new river station for inline structure
[image: ]
Click ok and its ready to enter the weir structure
[image: ]
Salient features of the weir to be incorporated in HEC-RAS

Weir Crest Level = 1433.975 m
Weir Height = 1.5m
Effective length of Weir = 6.6m
Two under sluices = 0.70m 
Two piers = 0.5m 
Top width of the weir = 1.0 to 1.8 m
Downstream apron length, L of 12m

Click Weir/embankment tool bar and insert values for the respective fields
Distance = 2, Width =1.8, Weir coefficient =1.7
For weir & under sluice section insert the table provided below
	Station
	Elevation

	14.21
	1433.975

	21.16
	1433.975

	21.16
	1432.475

	21.86
	1432.475

	21.86
	1433.975

	23.85
	1433.975

	28.45
	1433.975

	30.02
	1433.975

	30.80
	1433.975

	30.80
	1432.475

	31.50
	1432.475

	31.50
	1433.975

	34.20
	1433.975



[image: ]
Click Ok and Exit
[image: ]
Select cross-section 4.2 while in the Cross Section Data window. Choose Ineffective Flow Areas from the Options pull down menu.
Enter the stations and elevations from Table below in the Ineffective Flow Areas window that represent the blockage in the river channel due to the Weir abutments. Press OK 

	Station
	21.16
	31.5

	Elevation
	1436.073
	1436.073


[image: ]


Click on the Gate button in the inline structure data and insert the values provided below
Height = 0.7
Width = 0.7
Invert = 1432.94
Stations = 21.51
  			     = 31.15
Orifice Coefficient = 0.8
Sluice Coefficient = 0.6
Weir Coefficient = 1.7
[image: ]
Choose Exit from the File pull down menu of the inline structure data Editor window.
Choose Exit Geometry Data Editor from the File pull down menu of the Geometric Data Window.
Save the project. 
In the main HEC-RAS window, select Steady Flow Data from the Edit pull down menu to enter flow and boundary conditions. 
[image: ]

Enter a 2 in the "Number of profiles to be calculated" input for the two profiles modeled.
Enter the flow at the farthest upstream station of each reach for each profile to be modeled. Once a flow value is entered at the upstream end of a reach, it is assumed that the flow remains constant until another flow value is encountered. For PF-1 insert flow = 24.84 and for PF-2 insert flow = 29.52 at station 5, which is 50 and 100 Year return period flood. 
[image: ]
Click on the Reach Boundary Conditions button to enter the steady flow boundary conditions window. Since we are computing multiple water surface profiles, click on Set Boundary for all profiles. 
[image: ]
For mixed flow, flow which has both super and subcritical sections, select both an upstream and downstream boundary condition. A mixed flow regime is anticipated, therefore, all upstream and downstream boundary conditions are required. 
For Down Stream select Normal Depth = 0.04, and choose Known W.S. UP Stream The known W.S. elevations are determined from a downstream weir.(Refer Petu Design Report)
		
	Flow
	Known Water Surface Elevation

	Profile-1
	24.84
	1433.42

	Profile-2
	29.52
	1433.53


[image: ]

Select Ok and Exit boundary condition to return to Steady Data Flow window 
Select Gate opening from option pull down menu 
[image: ]

Insert 0.7 for # open Ht and 1 for #open then click ok
[image: ]
Select Exit Flow Data editor from the File pull down menu of the Steady Data Flow window to return to main HEC-RAS window.
Select Save Project from the File pull down menu in the main HEC-RAS window to save all geometric and flow data.
Select Steady Flow Analysis from the Simulate pull down menu of the main HEC-RAS window. Choose Mixed Flow Regime.
[image: ]
· Select Critical Depth Output Option from the Options pull down menu of the Steady Flow Analysis window. Choose Critical Always Calculated, and press OK
[image: ]

Press Compute in the Steady Flow Analysis window to begin the HEC-RAS analysis. 
When the following screens are visible the simulation has been run
[image: ]
Let’s look at the characteristics of the bank full flow. Click on the tables tab of the main menu interface. Select options/profiles to view the results
[image: ]

[image: ]

This table provides water surface elevation, velocity, Froude number, area, width, energy grade line etc. Many more options are available under options/define table.
we can go back to the main menu and the plot profile tab to examine the flow profile
	[image: ]

[bookmark: _Toc470401285][bookmark: _Toc531650033]case study for petu irrigation canal & drop structures
[bookmark: _Toc470401286][bookmark: _Toc531650034]Preparation of working environment
This practical exercise will help how to model Irrigation canal and Drop Structures 
[bookmark: _Toc470401287][bookmark: _Toc531650035]Getting started
Defining a project
Find the HEC-RAS folder in the Start Menu and click on HEC-RAS to start the program
[image: ]
Select New Project from the File pull down menu in the main HEC-RAS window
[image: ]

Select a drive, and select a path by double clicking in the directory box of the New Project window. For this example, double click on the data subdirectory for c:\Petu Diversion Weir folder\ Enter a title Petu Canal and Drop Structure and the filename is Petu Canal and Drop Structure. prj Click OK 
[image: ]

The English System of units is the default. To use the Metric System, select Unit System from the Options pull down menu in the main HEC-RAS window to change from the English System to the Metric System.
[bookmark: _Toc470401288][bookmark: _Toc531650036]Incorporation cross sectional data
Select Geometric data from the Edit pull down menu in the main HEC-RAS window
[image: ]
In the Geometric Data window, click on the River Reach tool with the mouse and draw the following river schematic by clicking the left mouse button and dragging the reach in the direction of the flow. 
[image: ]
Double-click the mouse to end the reach. Give each reach a name RSC-1 Canal. 
[image: ]
Click on the Cross Section tool on the left side of the Geometric Data window
	
[image: ]

Select Add a new Cross Section from the Options pull down menu in the Cross Section Data window and enter the river station label. HEC-RAS requires that canal cross-sections be entered starting upstream using the highest number as a "river station" label and proceeding downstream in the direction of flow
	[image: ]
Enter data provided below for the Upstream reach (Reach 31.212)
Downstream reach length = 3
Manning’s Value = 0.014
Main channel reach station, Left bank =0.00 and Right Bank = 0.2
Contraction coefficients = 0.1 and Expansion coefficients =0.3
	Station
	31.212
	
	28.212
	
	21.212
	
	11.212
	
	1.212
	
	0

	Distance to D/S
	3
	
	7
	
	10
	
	10
	
	1.212
	
	0

	0
	1432.765
	0
	1432.315
	0
	1429.765
	0
	1426.765
	0
	1423.765
	0
	1423.583

	0
	1432.415
	0
	1431.965
	0
	1429.415
	0
	1426.415
	0
	1423.415
	0
	1423.233

	0.2
	1432.415
	0.2
	1431.965
	0.2
	1429.415
	0.2
	1426.415
	0.2
	1423.415
	0.2
	1423.233

	0.2
	1432.765
	0.2
	1432.315
	0.2
	1429.765
	0.2
	1426.765
	0.2
	1423.765
	0.2
	1423.583




[image: ]

Repeat the above Steps until all canal stations for the reach (from reach-28.212 up to reach-0) are entered. Then, change the Reach using the Reach pull-down menu and enter data for the rest of the reaches. Press the apply data button after each cross section is entered. 
After all the cross section data is entered, select Exit Cross Section Editor from the Exit pull down menu in the Cross Section Data window
Your main geometry menu should now look like this
[image: ]
[bookmark: _Toc470401289][bookmark: _Toc531650037]Incorporating drop into a HEC-RAS analysis
Hec-Ras requires two cross section u/s and d/s of Drop structure located at reach- 28.212, 21.212 and 11.212 to do so
In order to insert Drop Structures the cross section should be adjusted as follows
Click cross section tab
Select cross section at station 28.212
From option drop down menu select copy current cross section
Enter 28.21 at river station 
Since the values are inherited from the u/s cross section i.e the drop height is 1.5 and subtract from elevation values as given in the table 
Change D/s reach length for station 28.212 = 0.002 and for copied cross section leave it as it is.
	Station
	New Cross 
Section
	D/s Reach
Length
	CBL U/S 
of Drop
	CBL D/S
 of Drop
	TBL U/S of Drop
	TBL D/S of Drop

	28.212
	28.21
	0.002
	1431.965
	1430.465
	1432.315
	1430.815

	21.212
	21.21
	0.002
	1429.415
	1427.915
	1429.765
	1428.265

	11.212
	11.21
	0.002
	1426.415
	1424.915
	1426.765
	1425.265


[image: ]
Repeat the same steps for stations 21.212 and 11.212 as station 28.212.
Your Canal profile plot should now look like this
[image: ]
Click tools in geometric data and select XS interpolation
Click in interpolation and for max distance between XS’s insert 2
In Reach drop down menu select All Reach
Click interpolate Xs’s
Click Tables in geometric data and select Manning’s n or K value
Click and select tabs n#1, n#2 and n#3
Click Set Values and insert value = 0.014
Click Ok and make sure all cross sections have manning’s value entered 
Your main geometry menu should now look like this
[image: ]
Choose Exit Geometry Data Editor from the File pull down menu of the Geometric Data Window.
Save the project. 
In the main HEC-RAS window, select Steady Flow Data from the Edit pull down menu to enter flow and boundary conditions. 
Enter a 1 in the "Number of profiles to be calculated" input for the two profiles modeled.
Enter the flow at the farthest upstream station of each reach for each profile to be modeled. Once a flow value is entered at the upstream end of a reach. For PF-1 insert flow = 0.046 at station 31.212, which is the designed discharge.	
[image: ]
Click on the Reach Boundary Conditions button to enter the steady flow boundary conditions window. 
For Canal modeling the flow is assumed to be steady and uniform, thus the flow which will have subcritical sections, select downstream boundary condition. 
For Down Stream select Normal Depth = 0.15. (Refer Petu Design Report)
[image: ]
Select Ok and Exit boundary condition to return to Steady Data Flow window
Select Exit Flow Data editor from the File pull down menu of the Steady Data Flow window to return to main HEC-RAS window.
Select Save Project from the File pull down menu in the main HEC-RAS window to save all geometric and flow data.
Select Steady Flow Analysis from the Simulate pull down menu of the main HEC-RAS window. Choose Subcritical Flow Regime.
[image: ]
Select Critical Depth Output Option from the Options pull down menu of the Steady Flow Analysis window. Choose Critical Always Calculated, and press OK
[image: ]

Press Compute in the Steady Flow Analysis window to begin the HEC-RAS analysis. 
When the following screens are visible the simulation has been run
Click on the tables tab of the main menu interface. Select options/profiles to view the results
[image: ]

This table provides water surface elevation, velocity, Froude number, area, width, energy grade line etc. Many more options are available under options/define table.
we can go back to the main menu and the plot profile tab to examine the flow profile
	[image: ]

On the main menu click view 3D multiple cross section tab to visualize the canal flow in three-dimension perspective.


[image: ]
On the main menu click view cross section tab 	
[image: ]

         You are done!!!




	
[bookmark: _Toc531650038]MANNUAL FOR Z-PROFILE, L-SEC
[bookmark: _Toc470628571][bookmark: _Toc531650039]basic knowledge of z-profile and l-sec
[bookmark: _Toc470628572][bookmark: _Toc531650040]The Z-profile & L-sec software suite
Z-Profile is an Auto-LISP and L-Sec is a VB.net routines routine to facilitate the generation of profile drawings from data prepared in Excel spreadsheets. It has been tested for compatibility with AutoCAD and IntelliCAD. to meet the needs of irrigation and drainage projects, for which large numbers of profile drawings are required.
[bookmark: _Toc470628573][bookmark: _Toc531650041]Purpose
Both Z-Profile and L-Sec are application software’s that are used to prepare profile drawing including: 
· Irrigation and Drainage Canals Profiles
· Sprinkler and Drip Main and Sub Main Profiles
· Water supply Delivery and distribution profiles
· Road Profiles
[bookmark: _Toc470628574][bookmark: _Toc531650042]Scope
This guideline covers the basic procedures for Diversion weir, Irrigation canal and selected Irrigation canal structures (Case study of Petu SSI Project).
[bookmark: _Toc470628575][bookmark: _Toc531650043]Computer requirements
Pentium III with Microsoft, Windows XP, Vista or Windows 7, 1024x768 display or higher
[bookmark: _Toc470628576][bookmark: _Toc531650044]case study for petu canal profile preparation
[bookmark: _Toc470628577][bookmark: _Toc531650045]Preparation of working environment
This practical exercise will help how to prepare Irrigation and drainage canal profile drawing preparation for Petu SSIP.
[bookmark: _Toc470628578][bookmark: _Toc531650046]Getting started for Z-Profiles
Installation
For AutoCAD users, copy Zprofile.dcl and Zprofile.lsp into the C:\Program Files (x86)\AutoCAD \support directory. 

Data preparation
Z-Profile will handle up to 9 sets of data. The first column contains the X-axis (chainage/ station) data. The other columns contain level data. A typical calculation spreadsheet is shown in Figure below. 
[image: ]

Zprofile can handle blank data in any of the columns, i.e. there does not need to be a complete set of data for each chainage.

The data have to be input as a fixed format text file containing 
I. The data title (as required on the drawing) for each column;  
II. Each data column 9 characters wide.
The process to create this file from an Excel spreadsheet is
Select the visible columns and change the width to 10 (Format > Column > Width) 
Insert rows for the data column headings and type in the headings in the first visible column 
[image: ]


Note: Each Columns should be filled as indicated below
Column A = Chainage Data
Column B = Original Ground Data
Column C = Canal Bed Level Data
Column D = Full Supply Level Data
Column E = Top Bank Level Data
Column F = Cut Depth Data
Column G = Fill Depth Data
Remember the file name, location and number of columns of data
Recommended data range is 50
Save the file as Formatted Text (space delaminated). This will receive a. prn suffix by default. 
[image: ]
[bookmark: _Toc470628579][bookmark: _Toc531650047]Plotting a long section with Z-Profile
Open the AutoCAD program and from the Tools menu select Load application 
[image: ]


Type Zprofile.lsp in the file name and press Load 
[image: ]
Type Zprofile to run the program press Enter
[image: ]

Select the data file and press Open 
[image: ]
Enter 7 as number of columns and press Enter
[image: ]
Zprofile then loads the data and presents a dialogue box with suggested default values for the scales or it can be adjusted as required.
[image: ]
Zprofile will then draw the profile 
[image: ]

The profile will then need to be edited to suit the needs of the project
[bookmark: _Toc470628580][bookmark: _Toc531650048]Getting started for L-Sec
Installation
For AutoCAD users, copy FORMAY-ICT and STRLSEC-ICT into the C:\ directory. 
[image: ]

Copy and paste STRLSECBK-ICT.exe from STRLSECBK-ICT folder on the desktop
[image: ]
Similarly Copy and paste PERFORMA-LSEC.xls from L-sec folder on the desktop
[image: ]
Now you are ready to prepare data to prepare profile drawing

L-Sec will handle up to 7 sets of data. It is important to recall the columns are assigned to specific data. A typical L-Sec spreadsheet is shown in Figure below. 

[image: ]

Brief Description Items in Performa spread Sheet
REACH # = is a column in which Reach number is entered (R-1, R-2…)
CH = is a column in which Chainage or Station data is entered (0,20,40…) 
NSL = is a column in which Original ground data is entered (1432,1433,1425….) 
DROP Ht = is a column in which Fall/Head loss data is entered (0.5,1,1.5….)
CBL = is a column in which Designed Canal Bed Level data is entered (1430.5,1430.2,1430.1….)
FSL = is a column in which Designed Full Supply Level data is entered (1431.0,1430.7,1430.6….)
TBL = is a column in which Designed Top Bank Level data is entered (1431.0,1430.7,1430.6….)
CUT = is a column in which Cut depth data is entered (0.2,0.85,0.45….)
FILL = is a column in which Fill height data is entered (0.5,0.75,0.55….)
FSD = is a column in which Full Supply Depth data is entered (0.5,0.4,0.35….)
FB = is a column in which Free Board data is entered (0.3,0.25,0.15….)
SLOPE = is a column in which Longitudinal Slope data is entered (500,400,150….)
CHAINAGE = is a raw in which Station at the Reach location is entered (0,20,40…)
DISCHARGE = is a raw in which discharge at the respective Reach is entered (0.4,0.6,0.2…)
LOSSES = is a raw in which Head loss at the respective Reach is entered (0.1,0.15,0.2…)
DEPTH = is a raw in which Full Supply Depth at the respective Reach is entered (0.1,0.2,0.3…)
WIDTH = is a raw in which Canal bed width at the respective Reach is entered (0.1,0.2,0.3…)
FREE BOARD = is a raw in which Free Board at the respective Reach is entered (0.1,0.2,0.3…)
BED SLOPE = is a raw in which Free Board at the respective Reach is entered (500,400,150….)
SIDE SLOPE = is a raw in which Side Slope at the respective Reach is entered (1,1.5,2….)
VELOCITY = is a raw in which velocity at the respective Reach is entered (0.6,0.5,0.9….)
CVR = is a raw in which Critical Velocity Ratio at the respective Reach is entered (0.9,0.95,1….)
BANKWIDTH = is a raw in which Bank width at the respective Reach is entered (0.5,1,1.5….)
VALUE OF "N" = is a raw in which Manning’s value at the respective Reach is entered (0.025….)
W. ALLOWANCE = is a raw in which Canal Duty at the respective Reach is entered (1.2,1.5….)
NAME OF CANAL = is a raw in which the name of a canal is entered (LMC-1, RMC-1….)
O/T CHAINAGE = is a raw in which Off taking canal Chainage is entered (0,20,40…)
FSL IN CANAL = is a raw in which Full Supply Level of parent canal is entered (1431.0,1430.7,1430.6….)
FSL IN O/T CANAL = is a raw in which Full Supply Level of off taking canal is entered 
WH = is a raw in which working head is entered
GCA = is a raw in which Gross command area is entered at the respective Reach is entered (40,25….)
CCA = is a raw in which Cultivable command area is entered at the respective Reach is entered (40,25….)
Type of structure = is a column in which the name of structure at the respective reach is entered (Drop, TO…)


Data preparation
For this exercise RSC-4 canal from Petu SSIP is selected
Salient Features of RSC-4 (Refer Petu SSIP Design report)
Number of Reach = 1
CCA = 5.165
Manning’s n =0.018
At REACH # cell: A5 enter R-1 since it has only one reach
Copy and Paste Cum.Dis (m) data from RSC-1.xls to CH column of PERFORMA.xls
Copy and Paste OGL (m) data from RSC-1.xls to NSL column of PERFORMA.xls 
Drop structures exist at chainage 5, 20, 40, 60, 80, 100 and 120 with drop height of 1-2.5 m and enter the drop height at column of DROP Ht of PERFORMA.xls with corresponding chainage
[image: ]
In similar pattern for DATA and DETAIL columns enter the corresponding data values 
CHAINAGE = 0 (beginning of the reach)
DISCHARGE = 0.029 
LOSSES = 0
DEPTH = 0.210 
WIDTH = 0.250 
FREE BOARD = 0.250 
BED SLOPE = 167 i.e. 1/0.006 
SIDE SLOPE = 0 i.e. Vertical cross 
VELOCITY = 0.79 
CVR = 1 or enter allowable value for respective canal lining
BANKWIDTH = 0.5
VALUE OF "N" = 0.018
W. ALLOWANCE = 0.75
O/T CHAINAGE = 0
FSL IN CANAL = 1392.56
FSL IN O/T CANAL =	1392.41
WH = 0.15
GCA = 5.940
CCA = 5.165
[image: ]
For STRUCTURE data column enter values from the table to the respective location 
	Type of structure
	Distance
	FALL

	DROP-1
	5.00
	2.50

	DROP-2
	20.00
	2.50

	DROP-3
	40.00
	2.50

	DROP-4
	60.00
	2.50

	DROP-5
	80.00
	2.50

	DROP-6
	100.00
	2.50

	DROP-7
	120.00
	1.00


[image: ]
Now it is ready to continue the calculation and Plotting the Longitudinal section
N.B. L-sec program unlike Z-profile is designed for Horizontal scale =300 and Vertical scale =100, whenever we need to change the scale we have to do it manually.
Save the file in any location that is comfortable for you
[bookmark: _Toc470628581][bookmark: _Toc531650049]Plotting a long section with L-Sec
Open Auto CAD window
Double click STRLSECBK-ICT.exe from desktop and the following window will popup
[image: ]
Click Calculation button and select the PERFORMA-LSEC.xls file in which previously prepared.
[image: ]
When automatic calculation completed it will fill, CBL, FSL…. As shown in the figure 
[image: ]

Click L-section button again select the PERFORMA-LSEC.xls file in which the calculation has already carried out.
N.B. don’t forget to open blank AutoCAD window
The initial Profile Drawing output should look like this and it needs manual editing i.e the scale and the fonts.
[image: ]
The Final Profile Drawing output after editing the fonts and scale (H=700, V=500) Should look like this.
[image: ]
You are done!!!!
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SSIGL 21:  Selected Application Software’s
[bookmark: _Toc531650050]MANNUAL FOR STABILITY ANALYSIS OF MICRO DAM
[bookmark: _Toc469868807][bookmark: _Toc531650051]basic knowledge of geostudio
[bookmark: _Toc469868808][bookmark: _Toc531650052]The geo studio software suite
It includes the following software products:
SLOPE/W for slope stability analysis
SEEP/W for groundwater seepage analysis
SIGMA/W for stress and deformation analysis
QUAKE/W for dynamic earthquake analysis
TEMP/W for thermal analysis
CTRAN/W for contaminant transport analysis
AIR/W for air flow analysis
VADOSE/W for vadose zone and soil cover analysis
[bookmark: _Toc469868809][bookmark: _Toc531650053]Purpose
Geo-Studio is application software that is used to model almost any geotechnical problem including: 
Slope stability problems involving earth and rock slopes, including sloping Excavations, embankments, anchors, soil nails and geo-fabrics
Seepage affected by infiltration, drains, and injection wells 
Deformation resulting from staged loading, excavations, and fill placement or removal
Earthquake-induced deformation and pore-water pressure generation 
Contaminant transport problems
Thermal conduction and transient
Freeze-thaw problems
Unsaturated soil behavior and more…
[bookmark: _Toc469868810][bookmark: _Toc531650054]Scope
This guideline covers the basic procedures for Stability analysis of Micro Dam (Case study of Shimburit Earth Dam).
[bookmark: _Toc469868811][bookmark: _Toc531650055]Computer requirements
Pentium III with Microsoft, Windows XP, Vista or Windows 7, (recommended: Intel dual-core processor with 1GB of RAM), 1024x768 display (recommended: 1280x1024 or higher).
[bookmark: _Toc469868812][bookmark: _Toc531650056]case study for stability analysis of shimburit earth dam
[bookmark: _Toc469868813][bookmark: _Toc531650057]Preparation of working environment
This practical exercise will help to obtain the minimum factor of safety and the critical surface profile
[bookmark: _Toc469868814]

[bookmark: _Toc531650058]Getting started
Defining a project
Creating a new SEEP/W project from the Start Page of GeoStudio
[image: ]
Click SEEP/W to start a new project
[image: ]

Write the name of analysis as SEEP/W, and description as Shimburit Micro Dam.
Analysis as: Steady-State Seepage Analysis and Description as SEEP/W Exercise
Adapt the default values for the rest

Setting 
Click set dialog box and select Page
[image: ]
Click mm to set dimension in SI unit, Width 683mm and Height 300mm ,Click Ok
[image: ]
Click set dialog box and select Units and Scale
Choose SI Units for tick box
Set scale for both horizontal and vertical as 1:300
For Problem extents insert minimum X = -2.0873 and minimum Y= -5.08 the maximum extent computes automatically, Click ok
[image: ]
Click set dialog box and select Grid
Make the X:Y, aspect ratio 0.5:0.5, Tick both display grid and snap to grid and Close
[image: ]
Your final working area should look like this. It is recommended to save your file frequently
[image: ]

Click set dialog box and select Axes 
Tick Left Axes, Bottom Axes and Axis Number then Click ok
[image: ]
On Set Axis size dialogue insert
X axis Min =12, Increment Size = 2 and # of increment = 89
Y axis Min = 8, Increment Size = 1 and # of increment = 50
After Clicking ok Your final working area should look like this
[image: ]
[bookmark: _Toc469868815][bookmark: _Toc531650059]Defining the geometry
Before defining the geometry in SEEP/W, it is convenient to first sketch the problem. It is planned to analyze the stability of a homogenous dam (refer Shimburit Dam Drawing).
Dam height = 16.0 m
Free board = 2.3 m
Reservoir depth = 11m
Top width = 5.0m
U/s slope H:V = 3:1 and D/S slope H:V= 2:1
It is going to rest on 4m soil and then competent rock beyond.
[image: ]

When creating the Shimburit model (Refer Drawing), first draw the geometry; create and assign materials, draw pore-water pressure conditions and draw the slip surface geometry, which will control the mode of failure you are going to analyze. The lines are considered as objects, which can be adjusted or deleted using the Modify: Objects command

Drawing Geometry
Start by drawing the geometry of Individual embankment dam regions.
Click Draw dialog box and select Region
[image: ]
When you click the region command you will get cross hair that will be used for plotting the region.
[image: ]

For this exercise there are six regions
Region 1: Embankment Material
Region 2: Filter Material (Fine Sand)
Region 3: Filter Material (Medium Sand and Gravel)
Region 4: Rock Toe Material
Region 5: Foundation Material
Region 6: Competent rock
Region will be created by clicking the coordinates that will define the required geometry and Click the left mouse button to create region points. Once the polygon region has been closed, you can either continue to draw additional regions, or you can exit the draw regions mode. Move the cursor to the following coordinates respectively in clockwise direction.

	Regions
	Material
	Points

	Region 1
	Foundation Material-1
	1,2,3,4

	Region 2
	Foundation Material-2
	5,6,7,8

	Region 3
	Filter Material-1- (Fine Sand)
	9,3,4,10,11,12,13,14,15

	Region 4
	Filter Material-2- (Medium Sand and Gravel)
	13,16,17,18,19,20,15,14

	Region 5
	Filter Material-3- (Fine Sand)
	20,21,22,19

	Region 6
	Closely Jointed Basalt Rock
	7,23,24,25,26,18,19,22,21,20,15,9,3,2,27,28,5,8

	Region 7
	Embankment Material
	29,30,31,32,33,34,16,13,12,11,10,4,1,2,27,28,5,6,7,35

	Region 8
	Rock Toe Material
	17,16,34,18


1) Foundation material-1
Draw region using X-Y values for Foundation Material-1 Staring from point 1 - point 4
Click left mouse and then click right mouse to finish Foundation Material-1 region
	
	X (m)
	Y (m)

	Point 1
	112.3887
	19.0198

	Point 2
	112.1417
	18.7870

	Point 3
	124.6833
	18.1180

	Point 4
	124.6821
	18.3899


2) Foundation material-2
Draw region using X-Y values for Foundation Material-2 Staring from point 5 - point 8
Click left mouse and then click right mouse to finish Foundation Material-2 region
	
	X (m)
	Y (m)

	Point 5
	101.8302
	18.695443

	Point 6
	101.4858
	19.02025

	Point 7
	50.0877
	20.0200

	Point 8
	50.0892
	19.71985


3) Filter material-1- (Fine Sand)
Draw region using X-Y values for Filter Material-1 Staring from point 9 - point 15
Click left mouse and then click right mouse to finish Filter Material-1 region
	
	X (m)
	Y (m)

	Point 9
	124.6838
	17.7507

	Point 3
	124.6833
	18.1180

	Point 4
	124.6821
	18.3899

	Point 10
	124.6794
	18.7459

	Point 11
	138.1737
	18.7430

	Point 12
	139.9533
	20.5016

	Point 13
	140.1273
	20.4128

	Point 14
	137.4558
	17.7514

	Point 15
	137.4558
	17.7365


4) Filter material-2- (medium sand and gravel)
Draw region using X-Y values for Filter Material-2 Staring from point 13 - point 16
Click left mouse and then click right mouse to finish Filter Material-2 region


	 
	X (m)
	Y (m)

	Point 13
	140.1273
	20.4128

	Point 16
	140.4216
	20.266

	Point 17
	137.6864
	17.5417

	Point 18
	150.2709
	17.5388

	Point 19
	150.2719
	17.3932

	Point 20
	137.454
	17.3896

	Point 15
	137.455
	17.7365

	Point 16
	140.4216
	20.266


5) Filter material-3- (Fine sand)
Draw region using X-Y values for Filter Material-2 Staring from point 20 - point 19
Click left mouse and then click right mouse to finish Filter Material-3 region

	 
	X (m)
	Y (m)

	Point 20
	137.454
	17.3896

	Point 21
	137.4527
	17.1885

	Point 22
	150.2814
	17.1819

	Point 19
	150.2719
	17.3932


6) Closely jointed basalt rock
Draw region using X-Y values for Basalt Rock Staring from point 7 - point 8
Click left mouse and then click right mouse to finish Basalt Rock region
	 
	X (m)
	Y (m)

	Point 7
	50.0877
	20.02

	Point 23
	25.0877
	20.07

	Point 24
	25.1877
	12.045

	Point 25
	175.0794
	12.045

	Point 26
	175.2127
	17.52

	Point 18
	150.2709
	17.5389

	Point 19
	150.272
	17.3932

	Point 22
	150.2814
	17.1819

	Point 21
	137.4528
	17.1885

	Point 20
	137.454
	17.3896

	Point 15
	137.4558
	17.7366

	Point 9
	124.6838
	17.7507

	Point 3
	124.6833
	18.118

	Point 2
	112.1418
	18.7871

	Point 27
	108.8874
	15.7198

	Point 28
	104.9862
	15.7195

	Point 5
	101.8303
	18.6954

	Point 8
	50.0892
	19.7199



7) Embankment material
Draw region using X-Y values for Embankment material Staring from point 29 - point 35
Click left mouse and then click right mouse to finish Embankment material region


	 
	X (m)
	Y (m)

	Point 29
	80.3875
	28.4706

	Point 30
	104.5954
	36.5198

	Point 31
	109.5867
	36.5196

	Point 32
	125.2863
	28.519

	Point 33
	128.2866
	28.5198

	Point 34
	141.8844
	21.7296

	Point 16
	140.4216
	20.266

	Point 13
	140.1273
	20.4129

	Point 12
	139.9533
	20.5017

	Point 11
	138.1737
	18.7431

	Point 10
	124.6794
	18.7459

	Point 4
	124.6821
	18.39

	Point 1
	112.3887
	19.0198

	Point 2
	112.1418
	18.7871

	Point 27
	108.8874
	15.7198

	Point 28
	104.9862
	15.7195

	Point 5
	101.8303
	18.6954

	Point 6
	101.4858
	19.0203

	Point 7
	50.0877
	20.02

	Point 35
	77.3926
	28.4695



8) Rock toe material
Draw region using X-Y values for Rock Toe Material Staring from point 17 - point 18
Click left mouse and then click right mouse to finish Basalt Rock region
	
	X (m)
	Y (m)

	Point 17
	137.6865
	17.5417

	Point 16
	140.4216
	20.2660

	Point 34
	141.8844
	21.7296

	Point 18
	150.2709
	17.5389


Your final Drawing area should look like this. 
[image: ]
[bookmark: _Toc363890348][bookmark: _Toc469868816]

[bookmark: _Toc531650060]Creating materials
Materials are first created and then assigned to geometry objects. 

Creating material
Click on KEYIN and click Materials
[image: ]
For the first region add a new material, name it as Embankment Material
Material model from the drop down list as Saturated/Unsaturated
Hydraulic Property as default or none
[image: ]
For the rest of regions repeat the same step

[image: ]

Setting the hydraulic conductivity function
For a steady-state analysis, only a conductivity function needs to be defined. 
The “dot-dot-dot” button is used extensively in GeoStudio to indicate that additional features can be accessed. Click on this button to create a hydraulic conductivity function. 

[image: ]
Click on the “add” button, give the function a name as Embankment Conductivity and select the type from the dropdown list Data Point Function. 
[image: ]

We are defining a data point function of Matric suction, which is a positive value, and a hydraulic conductivity. Often a 2-point function is sufficient as a starting point. Additional points can be added and adjusted by editing the function directly. It is also possible to insert the hydraulic function using the conductivity script function that will be given separately.

Click Matric Suction and conductivity box to insert the following 4 points for embankment conductivity
· Hydraulic conductivity values for Fine Sand Material
	Matric Suction (kPa)
	Kx (m/s)

	2
	1e-5

	6.86
	2.50e-6

	36.98
	2.72e-8

	100
	1e-8


[image: ]

Click the edit data points at the bottom and then the add points to edit the graph and insert additional points.  It is possible to adjust the graph by pulling the added points by clicking move points button.

Once you are happy with your function, you can then close the KEYIN: Hydraulic conductivity dialogue box to be returned to the KEYIN: Materials Properties view. From the Hydraulic properties functions (Hydraulic Conductivity function) click the dropdown menu to change it into Embankment Conductivity.
[image: ]
Click Matric Suction and conductivity box to insert the following 4 points for the rest of materials as given in a table.

· Hydraulic conductivity values for Filter Material (Fine Sand)
	Matric Suction (kPa)
	Kx (m/s)

	2
	0.0001

	6.2
	3.69e-05

	20.81
	5.12e-06

	100
	1.00e-06






· Hydraulic conductivity values for Filter Material (Medium Sand and Gravel)
	Matric Suction (kPa)
	Kx (m/s)

	2
	0.001

	8.55
	0.000313

	34.95
	5.45e-05

	100
	1.00e-05


· Hydraulic conductivity values for Rock Toe Material
	Matric Suction (kPa)
	Kx (m/s)

	2
	0.1

	5.61
	0.064795

	19.24
	0.021258

	100
	0.01





· Hydraulic conductivity values for Foundation Material
	Matric Suction (kPa)
	Kx (m/s)

	2
	1e-007

	5.80
	2.3053445e-008

	22.32
	8.5039671e-010

	100
	1e-010


· Hydraulic conductivity values for Closely Jointed Basalt Rock
	Matric Suction (kPa)
	Kx (m/s)

	2
	1.00e-15

	6.31
	4.99e-17

	24.28
	2.52e-19

	100
	1.00e-20


Assigning the material to the region
The function has now been assigned to the soil. The material can now be assigned to the geometry regions.  
Choose Materials from the DRAW dropdown menu to assign the material properties (hydraulic function) to the embankment soil. Later on we will also follow the same procedure to assign the hydraulic function for the foundation soil. 
Click Draw and select Material
[image: ]
Make sure the assign radio button on and Embankment material is selected
Move the cursor to Embankment region and left click
The embankment boundary colure will be changed 
[image: ]
Similarly move the cursor to filter, foundation, Basaltic rock and rock toe to assign materials in similar fashion
[image: ]
[bookmark: _Toc469868817][bookmark: _Toc531650061]Fixing boundary condition
Select Boundary Conditions from the DRAW menu 
[image: ]
Click KEYIN boundary conditions to assign a boundary for the reservoir
[image: ]
Click add button, add new hydraulic boundary condition, give name i.e. Full reservoir =35 m from river bed level and change the colour. Make sure that on the Type pull down menu to Head (H) and insert the reservoir depth i.e. 35 m in the action box
[image: ]
[bookmark: _Toc469868818][bookmark: _Toc531650062]Applying boundary to the geometry
Zero pressure boundary
A zero pressure boundary condition will be applied to the filter toe, which is a geometry line. Make sure that the select line is clicked
[image: ]
Seepage face
A potential seepage face boundary condition will be applied to the downstream face, which is an edge. A potential seepage face is a special boundary condition that is used when you want the solver to locate the position of where a seepage face might develop. 
Select the potential seepage face from drop down menu to fix it for the downstream. Make sure that line is selected and click the downstream face of the dam.

[image: ]
Adding reservoir
To add the reservoir from sketch menu select polyline and draw the upstream reservoir level starting from coordinate (25, 35) to (100, 35).
Fix the boundary by selecting FRL = 35, and make sure that line is selected. Then click the upstream face of the dam.
[image: ]
Breaking a region
In order to locate the intersection point of the reservoir and upstream slope of the embankment you may zoom it and Click on draw points and locate exactly at the intersection the point. In this case point 35.
[image: ]
To break up a region edge so that you can apply the boundary condition, such as the reservoir total head to only a portion of the edge (i.e. excluding the free board), you may need to insert a region point. 
	[image: ]
Click draw boundary condition and select the reservoir boundary then click the remove icon somewhere the line below point 30 and 36. You will see a green boundary line for the upstream slope and the reservoir water boundary will end up to point 36.
[bookmark: _Toc469868819]

Viewing the finite element
You can view the finite element mesh using DRAW: Mesh Properties.
[image: ]
Change Approximate Global element size as 1.5 m

Determining flux section
One of the objectives of this analysis was to compute the amount of flow through the earth dam. To do this, we can use a flux section. 
Click Draw and select flux section
Click OK button and draw the flux section at one point, you may select at the centre or axis of the dam
[image: ]
Now it’s time to solve the problem
[bookmark: _Toc469868820]

[bookmark: _Toc531650063]Solve and contour
Verify/optimize
Before that you may review the data by clicking on View or Optimize icon
[image: ]
Solve and contouring
The solver for SEEP/W can be launched by clicking on the “SOLVE” icon. Click the start button to activate the solver.
You can view the results directly by clicking on the CONTOUR icon in the analysis toolbar. By default, the CONTOUR results will include velocity vectors, the location of the zero pressure contour and total head contours.
The flux section results can be viewed by selecting flux labels from the DRAW Menu. Clicking on the flux section will make the total flux value appear
[image: ]
Flow path
Flow paths represent the path that a drop of water would travel from the reservoir through the dam. Draw a flow path by using the appropriate pull down menu and then click the cursor anywhere within the profile
Additional features that you may exercise by your self
Remember, at any time you can change the way the CONTOUR information is presented by using the View Preferences pull down menu. 
You can also retrieve information from specific locations on the profile. 
Select VIEW: Result Information and then click on the location that you’re interested in. If you hold the CTRL key down, you can gather information from several different locations.
You can label your contours using DRAW: Contour Labels. 
There are many different types of parameters you can contour. Use DRAW: Contours to view some different results. Three default contour options are available, but you can also add other options to the list using the Add button.
[bookmark: _Toc363890364][bookmark: _Toc469868821][bookmark: _Toc531650064]Reporting 
New to GeoStudio 2007 is a reporting feature. If you need to generate a report of your input data, select Report from the VIEW menu. Once you save the report file, your default word processing program will open with a generated report. You can now insert pictures, apply style templates or add and delete data.
[bookmark: _Toc469868822][bookmark: _Toc531650065]Adding a new analysis
GeoStudio 2007 has the ability to run many different analyses within the same project file. The geometry is considered project specific, but you can change boundary conditions, material properties or even different types of analyses.
[bookmark: _Toc469868823][bookmark: _Toc531650066]Slope/W
Use the SEEP/W computed pore-water pressures in a stability analysis using SLOPE/W. 
Click on KEYIN and then analysis to use the results of SEEP/W analysis for SLOPE/W.
Click the add button to select the type of analysis and then Limit equilibrium.
[image: ]
You may give a name like slope stability analysis and description
Select Morgenstern-Price and ensure that a half-sine function is being applied in the settings dialog box. 
[image: ]
Under the pore-water pressure (PWP) option, select parent analysis
Under the slip surface tab, select Direction of movement left to right and Slip surface option as Entry and Exit
[image: ]
[bookmark: _Toc469868824][bookmark: _Toc531650067]Assigning materials
Creating material data
Click on KEYIN and click Materials
[image: ]

[image: ]
For the first region add a new material, name it and select a strength model from the drop down list. You can use the tab key to move between the edit boxes. You may put the name as Embankment Soil, Material model as Mohr-Coulomb and Basic material properties as. You may change the colour of the soil by clicking set and select color.
Unit weight= 16 KN/m3, 
Cohesion = 29 kPa and 
Phi =15o
To create a second material, you have choices; you can either add one, or you can clone the existing material and repeat similar steps

Basic material values for Filter Material (Fine Sand)
Unit weight= 18 KN/m3, 
Cohesion = 0 kPa and 
Phi =30o
Basic material values for Filter Material (Medium Sand and Gravel)
Unit weight= 20 KN/m3, 
Cohesion = 0 kPa and 
Phi =36o
Basic material values for Rock Toe Material
Unit weight= 17 KN/m3, 
Cohesion = 0 kPa and 
Phi =40o
Basic material values for Foundation Material
Unit weight= 17 KN/m3, 
Cohesion = 29 kPa and 
Phi =30o
Basic material values for Closely Jointed Basalt Rock
Unit weight= 20 KN/m3, 
Cohesion = 0 kPa and 
Phi =40o

Assigning materials to each region
Choose materials from the DRAW: dropdown menu
[image: ]
Drag the respective material and click on respective region. The color for the region can be done by dropdown menu from assign
[image: ]
Repeat the same procedure for the rest of the region
[image: ]
Click Draw and select Slip Surface then Entry & Exit
[image: ]
Insert the following ranges for Entry range (left side) and Exit Range (Right side). This is for downstream slope analysis. But for upstream side the entry will right side and exit will be the left side.
[image: ]
Now the problem definition has been completed.  Congratulations!!! 
You can double check your input in different ways. For example: 
I. Select object information from the VIEW pull down menu. Click within any region to review the soil properties for that particular region. 
II. You can also view the information for any other geometric object.
III. Another way to review your input parameters is to use the DRAW: Contours feature available within DEFINE. 
IV. You can contour various parameters such as soil properties and pore-water pressures. Notice that when you define a piezometric line in SLOPE/W, the software considers the pore-water pressures to be hydrostatic both below and above the piezometric line. 
V. You can also label the contours. 
[bookmark: _Toc469868825]

[bookmark: _Toc531650068]Verifying the input data
Choose Verify from the TOOLS drop down list and SLOPE/W will run a number of checks to see if there are any errors or warnings.
[image: ]
[bookmark: _Toc469868826][bookmark: _Toc531650069]Solve and contour
Click on the SOLVE icon found on the Current Analysis Toolbar.
. [image: ]
Select the start button to activate the solver. In the solver window you will see the computed factors of safety for each of the various methods
[image: ]

Click the stat button to run the simulation. When the simulation is done correctly the status will be changed into Solved
[image: ]
You can review the results directly by clicking on the CONTOUR icon in the current analysis toolbar. 
[image: ]
The critical slip surface appears along with the critical factor of safety
[image: ]
[bookmark: _Toc469868827]

[bookmark: _Toc531650070]Stability analysis at end of construction
GeoStudio 2007 has the ability to analyze stability at the end of construction within the same project file. The geometry is considered project specific, by changing only PWP to Ru. 
Click window and select define
[image: ]
Click KeyIn and select Analyses
[image: ]
Click add and select Clone
[image: ]
Name it Stability analysis at end of construction
Select Ru from PWP drop down menu
[image: ]
Click KeyIn and select pore water pressure
[image: ]
Insert 0.35 for embankment material and 0 for other materials then close
[image: ]
Using similar steps verify and solve
Click contour
[image: ]
[bookmark: _Toc464548788][bookmark: _Toc469868828][bookmark: _Toc531650071]Stability analysis results
The summary of results of the stability analysis conducted for the different loading conditions presented and comparison of the computed minimum factor of safeties with that of the required factor of safeties are presented in Table. According to the result the dam is stable for the two loading conditions. 

	Loading condition
	Recommended FoSmin
	Computed FoS

	End of construction
	1.3
	1.48

	Steady state seepage at normal level
	1.5
	1.62



You are done!!!
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SSIGL 21:  Selected Application Software’s
[bookmark: _Toc531650072]MANNUAL FOR MS-PROJECT
[bookmark: _Toc475647274][bookmark: _Toc531650073]basic knowledge of ms-project
[bookmark: _Toc475647275][bookmark: _Toc531650074]The MS-project software suite
Microsoft Project, the project management software program by Microsoft, is a very handy tool for project a manager that helps them develop a schedule, assign resources to tasks, track the progress, manage the budget, and analyze workloads for an ongoing project.

Microsoft Project is a specialized database that stores and presents thousands of pieces of data related to your project. These pieces of information interrelate and affect each other in a multitude of ways. Under-lying this project database is the scheduling engine, which crunches the raw project data you enter and presents the calculated results to you.

You can then manipulate and display this calculated data in various views to analyze the planning and progress of your project. This information helps you make decisions vital to the project’s success.
[bookmark: _Toc475647276][bookmark: _Toc531650075]Purpose
Microsoft Project is application software that is used to aid most of Projects including: 
Study and Design Projects
Construction projects so on…
[bookmark: _Toc475647277][bookmark: _Toc531650076]Scope
This guideline covers the basic procedures of construction project planning for irrigation and head work (Case study of Didiga SSI Project).
[bookmark: _Toc475647278][bookmark: _Toc531650077]Computer requirements
Pentium III with Microsoft, Windows 2000 and above, (recommended: Intel processor with 512 MB of RAM), 1024x768 display. 
[bookmark: _Toc475647279][bookmark: _Toc531650078]case study for didiga ssip construction scheduling
[bookmark: _Toc475647280][bookmark: _Toc531650079]Preparation of working environment
This practical exercise will help how to prepare Construction Scheduling using for Didiga SSIP.
4 [bookmark: _Toc474706737][bookmark: _Toc474710639][bookmark: _Toc475647281][bookmark: _Toc480286850][bookmark: _Toc480287380][bookmark: _Toc480287482][bookmark: _Toc480287791][bookmark: _Toc480287933][bookmark: _Toc480288092][bookmark: _Toc480293270][bookmark: _Toc480293373][bookmark: _Toc480293476][bookmark: _Toc480295173][bookmark: _Toc502394166][bookmark: _Toc524454550][bookmark: _Toc524464054][bookmark: _Toc531440605][bookmark: _Toc531441038][bookmark: _Toc531860499][bookmark: _Toc532555578][bookmark: _Toc531650080]
5 [bookmark: _Toc474706738][bookmark: _Toc474710640][bookmark: _Toc475647282][bookmark: _Toc480286851][bookmark: _Toc480287381][bookmark: _Toc480287483][bookmark: _Toc480287792][bookmark: _Toc480287934][bookmark: _Toc480288093][bookmark: _Toc480293271][bookmark: _Toc480293374][bookmark: _Toc480293477][bookmark: _Toc480295174][bookmark: _Toc502394167][bookmark: _Toc524454551][bookmark: _Toc524464055][bookmark: _Toc531440606][bookmark: _Toc531441039][bookmark: _Toc531860500][bookmark: _Toc532555579][bookmark: _Toc531650081]
5.1 [bookmark: _Toc474706739][bookmark: _Toc474710641][bookmark: _Toc475647283][bookmark: _Toc480286852][bookmark: _Toc480287382][bookmark: _Toc480287484][bookmark: _Toc480287793][bookmark: _Toc480287935][bookmark: _Toc480288094][bookmark: _Toc480293272][bookmark: _Toc480293375][bookmark: _Toc480293478][bookmark: _Toc480295175][bookmark: _Toc502394168][bookmark: _Toc524454552][bookmark: _Toc524464056][bookmark: _Toc531440607][bookmark: _Toc531441040][bookmark: _Toc531860501][bookmark: _Toc532555580][bookmark: _Toc531650082]
[bookmark: _Toc475647284][bookmark: _Toc531650083]Defining project scope
To define the project scope and communicate it to other key stakeholders, you develop and record the scope statement. The scope statement should include the following:
Project justification
Product description
Project constraints or limitations
Project assumptions
Project deliverables
Project objectives
This Sample construction scheduling project is based on the assumption that:
Active involvement of the local community in the construction process
Utilize minimal use of Machinery
Construction activities starts from head work and proceed towards the irrigation system 
[bookmark: _Toc475647285][bookmark: _Toc531650084]Getting started
Creating a project file 
Create a folder called Didiga SSIP anywhere you like
Start, All programs, Microsoft Office, Microsoft Project 2106
When you start Project, its Start screen appears
[image: ]
The Project Start screen includes options for creating a new plan or opening a plan
You create a new plan by clicking the Blank Project option on the Start screen. Doing so creates the new plan in the main Project interface
[image: ]
Here are the major parts of the Project interface; note the label of the active view along the left edge
Let’s walk through the major parts of the Project interface
The Quick Access Toolbar is a customizable area of the interface where you can add your favorite or frequently used commands.
Use the Tell Me box to quickly find a Project command, or help about that command or feature
The ribbon contains the commands you use to perform actions in Project.
Groups are collections of related commands. 
Commands are the specific features you use to perform actions in Project.
Zoom Slider: Simply zooms the active view in or out
File -> Options -> General tab -> Project view -> Default view then Select “Gantt with Timeline” from the dropdown box
[image: ]
File -> Options -> Display tab -> Show Indicators and Options Buttons for. Check all options
[image: ]
File -> Options -> Schedule tab -> Schedule -> Show Assignment Units. Choose “Decimal” from the dropdown box
[image: ]
File -> Options -> Schedule tab -> Calculation -> Calculate Project after Each Edit. Check the On button
[image: ]
Options -> Save tab -> Save projects -> Save Files In this format. Select Project (*.mpp). file name as Didiga SSIP Construction schedule


Start Date
Click Project tab -> Properties Group -> Project Information. 
A dialog box appears. In the start date box, type 11/11/15, or click the down arrow to display the calendar, select November 11, 2015. 
Click OK to accept the start date.
[image: ]
Click Project tab -> Properties Group -> Project Information. 
Click the arrow on the Calendar dropdown box. A list appears containing three base calendars and select a Standard Calendar as your project Calendar
[image: ]

Setting Your Project Calendar
Click Project tab -> Properties Group -> Change Working Time
[image: ]
To change the working time of a particular day of each week, Select the workweeks field
Click Details
Select the day (Monday-Saturday) and Mark the “Set day(s) to these specific working time”
Click Ok
[image: ]
Exceptions are used to modify a Project calendar to have a non-standard workday or a non-working day.
[bookmark: _Toc475647286][bookmark: _Toc531650085]Calculating duration for activities
A duration of the task is the estimated amount of time it will take to complete a task. As a project manager you can estimate a task duration using expert judgment, historical information, analogous estimates or parametric estimate. Before undertaking any work or project it is necessary to know the time it will take to accomplish, which is obtained or derived by dividing the total quantity by acceptable Norms. For example, 
Site Clearance for Camping site using four Daily Laborer
One Daily Laborer in 8 hr execute 10m2
Four crew each congaing four Daily Laborer in 8 hr. execute 160 m2
Total quantity for site clearance is 141 m2
Estimated time = 141/160 = 0.88 days 
Therefor for total days for this activity is ~ 1 Day 
The expected duration for the rest of the activities is calculated in similar fashion. For Didiga SSIP the duration is calculated and presented in File with the name of Norms Output and Resources.xls located in C-Excel file folder.
[bookmark: _Toc475647287][bookmark: _Toc531650086]Scheduling tasks
Tips
Brainstorming: Enter tasks as you think of them, without regard to sequence or grouping of related tasks. You can move and organize the tasks later.
Sequential: Think through the project from beginning to end, and enter tasks sequentially.
Phases: Think of the overall phases of the project. For example,
After those phases are in place, you can add tasks and subtasks beneath them.
Milestones and deliverables: Consider what the project is producing in terms of the mile-stones and deliverables. Enter those events as tasks and then add tasks and subtasks beneath them to flesh out the project. Your scope statement can be a valuable guide in this process


Entering Tasks
From C-Excel file folder open Didiga Duration.xlsx file
Copy all activities and durations
In Gantt Chart View, just click a cell directly below the Task Name Column Paste it
[image: ]
In Gantt Chart View, just click a cell directly below the Start Column and select November 11/ 2015.
Similarly select the same day for all activities
[image: ]
Click the top left corner to select all the tasks
[image: ]
Click the auto schedule tab
[image: ]
Then the task Mode will change to auto schedule mode
Sub Tasks
There can be a huge number of tasks in a project schedule, it is therefore a good idea to have a bunch of related tasks rolled up into a hierarchical chart view to help you organize the plan in a better way. It helps you organize your plan into phases. In MS Project, you can have several number of sub-tasks under any higher level task.

Mobilization and Access roads don’t have subtasks so leave them as it is 
But Camping and camping facilities have number of sub task that needs to be rolled up to do so select task from 3.1 to 3.9.5 (refer the Norm,output and resources excel file) 
[image: ]
Click Indent tab
[image: ]

Again there are sub tasks of Fencing i.e. from 3.9.1 to 3.9.5 and likewise by clicking indent tab create the sub tasks
The created task hierarchy looks like this
[image: ]

Creating Relationships between Tasks
Once you have a list of tasks ready to accomplish your project objectives, you need to link them with their task relationships called dependencies. For example, Task “Access road” can start once Task “Mobilization” has finished. These dependencies are called Links. 

In MS Project, the first task is called a predecessor because it precedes tasks that depend on it. The following task is called the successor because it succeeds, or follows tasks on which it is dependent. Any task can be a predecessor for one or more successor tasks. Likewise, any task can be a successor to one or more predecessor tasks. 

There are only four types of task dependencies; here we present them with examples.

Finish to Start (FS): The finish date of the predecessor task determines the start date of the successor task.
Finish to Finish (FF): The finish date of the predecessor task determines the finish date of the successor task.
Start To Start (SS): The Start date of the predecessor task determines the start date of the successor task.
Start to Finish (SF): The Start date of the predecessor task determines the finish date of the successor task.


Link Task
In order to organize the tasks in specific order you have to understand the tasks relationships. Start with mobilization->Camping and facilities->Head work->Main canal…
In the predecessor tab of “access road” enter “1” (which is ID no. of Mobilization indicating that it comes after mobilization completed)
[image: ]
Under Camping and camping facilities the sub task “site clearance” can be started at the same time as “access road” activity starts hence enter “2SS”
[image: ]
The rest of the task linkage is self-explanatory
The final task schedule (Partially) will look like this
[image: ]
[bookmark: _Toc475647288][bookmark: _Toc531650087]Create milestones
In Project Management, Milestones are specific points in a project timeline. They are used as major progress points to manage project success and stakeholder expectations. They are primarily used for review, inputs and budgets

Inserting a Milestone
Click Task name below mobilization
Click Task tab -> Insert group -> Click Milestone
[image: ]
MS Project names the new task as <New Milestone> with zero-day duration
Click on <New Milestone> to change its name to Milestone-1
Link it with “Mobilization” by entering “1” at the predecessor column of Mile stone
You can see the milestone appear with a rhombus symbol in the Gantt Chart View on the right.
[image: ]
Repeat the same procedures for all major tasks
[image: ]
[bookmark: _Toc475647289][bookmark: _Toc531650088]Setting up resources in the project
In project management terminology, resources are required to carry out the project tasks. They can be people, equipment, facilities or funding required for the completion of a project task. 

Optimum resource scheduling is the key to successful project management.

 
Resource types 
Work resources: People and equipment to complete the tasks. 
Cost resources: Financial cost associated with a task. 
Material resources: Consumables used as project proceeds. 
Adding resource names manually
To add resources to your project by simple data entry, follow these steps:
Click View, Resource Sheet to switch to the Resource Sheet view
Make sure the Entry table is applied. Click View, Table, Entry
In the first Resource Name field, type the name of a resource and then press Enter
Enter the names of other resources in the same way
If a piece of equipment will be integral to the successful completion of a task, enter its name as a work resource, just as you would a human resource
On the Initials column enter the abbreviation against each resources
On the Max column enter the number of resources to be utilized
On the standard rate column enter the hourly cost against each resources
[image: ]
Assigning resources to tasks
Click View Tab -> Split View group -> Details -> Task Form.
[image: ]

The window is split in two, Gantt Chart view and Task Form view below it.
In the Task Form view, click under the Resource Name column and select the resource.
Click the cell below the Resource Name column. 
Select the resource from the dropdown list.
On the unit’s tab enter the expected input for that specific task.
[image: ]

Repeat the same procedure for each task
During the process of assigning the resources will appear at the Gant chart and “Resources name” column
[image: ]
View critical path
Critical Path is the succession of connected tasks that will take the longest to complete. The word “critical” does not mean that the tasks are complex or important or need to be closely monitored, but the focus is on terms schedule that will affect the project finish date. 

So, if you want to shorten the duration of a project, you should first start with activities/tasks on the critical path. Critical path can be a single sequence of tasks (a single critical path) or there can be more than 1 critical paths for a single project. While schedule changes are made, it is also likely that the critical path will change from time to time. 

One needs to always focus on the Critical Path first, when one wants to apply fast-tracking or crashing to shorten the project duration. 

Slack or Float are key to understanding Critical path. There are two types of Float: 

Free Float: It is the amount of time a task can be delayed without delaying another task. 
Total Float: It is the amount of time a task can be delayed without delaying the completion of the project. 
To View Critical path
In Gantt Chart view -> Format Tab -> Bar Styles Group -> Check the Critical Tasks box ON
[image: ]
All task bars in the critical path, in the Gantt Chart View on the right, will turn Red in color.
[image: ]
Check resource allocations
Relationship between a resource’s capacity and task assignments is called allocation. This can be defined by 3 states: 
Under allocated: A skilled worker who works for 40 hours a week, has work assigned for only 20 hours. 
Fully allocated: A skilled worker who works for 40 hours a week, is assigned 40 hours of work in that week.
Over allocated: A skilled worker is assigned 65 hours of work, when he only has a 40-hour workweek. 
Click View Tab -> Task Views group -> Gantt Chart view.
Gantt Chart View displays some limited resource information, as shown in the following screenshot. It summarizes whether there may be a problem by the red over allocated icon in the indicator column.

[image: ]

The Resource Usage view displays resources and all tasks assigned to them underneath the Resource Name. The left-hand side of the screen lists the Resources and the Task Names together with columns of total information for the resource or assignment. The right-hand side shows a time-phased view.

Click View Tab -> Resource Views group -> Resource Usage view.
[image: ]
Resolve Resource over Allocation
One would need to either change the scope (reduce the amount of work), assign more resources, or accept a longer schedule to resolve over-allocation.

This can be achieved by using some of the following techniques:


I. Adjust Schedule 
By changing its lead or lag time when the resource has more tasks assigned than can be completed during a given time period. If you add delay that is less than or equal to the amount of slack on the task, you will not affect the finish date of the project. 

By default, when you link tasks, they are assigned a “Finish to Start” relationship. In this relationship, 
Lead: Lead time causes successor task to begin before its predecessor tasks ends. 
Lag: Lag time causes successor task to start after its predecessor task ends. 
Click Task Tab -> double-click the required Task under Task Name column -> Task Information dialog box opens -> Predecessors Tab
Under Lag heading column, enter the lag in terms of hours, days, weeks, or years.
[image: ]
II. Substitute resources or add additional resources
You can manually allot some other resource to the task.
Click View Tab -> Gantt Chart View -> Resource Name column. 
Click the box below the Resource Name column for the task you need the resource to be assigned.
[image: ]
Level Over-Allocated Resources
If resources are over-allocated you can use resource-leveling feature in MS Project 2016. It works by either splitting tasks or by adding delay to tasks to ensure the resource is not overloaded. Leveling can delay the individual task finish dates and even the project finish date. Project does not change who is assigned to each task, total work, or assignment unit values.
Leveling 
Steps in the Leveling process are only a few, but it is important to understand what each option does. The steps are as follows:
Click Resource tab -> Level group -> Leveling Options.
[image: ]

In Resource Leveling dialog box, under Resolving over allocations, leveling order dropdown box you can choose Standard. You have 3 options here: 
ID only option delays tasks only according to their ID numbers. Numerically higher ID numbers (for example, 10) will be delayed before numerically lower ID numbers. You might want to use this option when your plan has no task relationships or constraints. 
Standard option delays tasks according to predecessor relationships, start dates, task constraints, slack, priority, and IDs. 
Priority, standard option looks at the task priority value before the other standard criteria (Task priority is a numeric ranking between 0 and 1000). 
In Resource Leveling dialog box, under Resolving over allocations, you have several options that you can select. These are explained as follows: 
Level only within available slack. Selecting this checkbox would prevent Project from extending the plan’s finish date. MS Project will use only the free slack within the existing schedule, which could mean that resource over allocations might not be fully resolved. 
Leveling can adjust individual assignments. Selecting this checkbox allows Project to add a leveling delay (or split work on assignments if Leveling Can Create Splits in Remaining Work is also selected) independently of any other resources assigned to the same task. This might cause resources to start and finish work on a task at different times. 
Leveling can create splits in remaining work checkbox. This allows Project to split work on a task (or on an assignment if Leveling Can Adjust Individual Assignments on a Task is also selected) as a way of resolving over allocation. 
Level manually scheduled tasks. Selecting this allows Project to level a manually scheduled task just as it would an automatically scheduled task. 
After the desirable adjustment click level all
Leveling will remove entire over-allocation
Resource before Leveling
[image: ]
Resource after Leveling
[image: ]
Project Summary Task
Project summary task is at the highest level of the plan’s outline; it includes rolled-up details from all subtasks. It also represents the full duration of the plan, so it’s a handy way of seeing some essential details, such as the plan’s overall duration. Project automatically generates the project summary task but does not display it by default. 
To display the project summary task
Click anywhere in a Gantt chart view. When the focus is on a Gantt chart view, the label of the Format tab is Gantt Chart Tools.
On the Format tab, select the Project Summary Task check box
[image: ]

Project displays the project summary task at the top of the Gantt Chart view with an ID of 0.
[image: ]

[bookmark: _Toc475647290][bookmark: _Toc531650089]reporting project information
[bookmark: _Toc475647291][bookmark: _Toc531650090]Setting up and printing views
To set up and print a view, follow these steps:
Open the view and arrange the data as you want it to appear when printed.
Click File, Page Setup to display the Page Setup dialog box.
Specify the options you want for the printed view using controls on the different tabs of this dialog box. You can adjust the view orientation, page scaling, margins, header and footer, and so on. When finished, click OK.
On the Standard toolbar, click Print Preview. A picture of the view as printed appears, reflecting your Page Setup options.
[image: ]
[bookmark: _Toc475647292][bookmark: _Toc531650091]Reporting project information
Generating reports:
To see the list of available built-in reports:
Click Reports, Report. The Reports dialog box appears, showing the following categories. 
[image: ]

The report categories are as follows:
New Reports
Dashboards
Resources
Costs
In progress
Custom….
To select and print a report, follow these steps:
Click View, Reports.
In the Reports dialog box, double-click the category you want.
In the dialog box that appears, double-click the report you want.
If a dialog box prompts you for more information, such as a date range, enter it and then click OK.
The report appears in a Print Preview window
When ready to print the report, click Print on the Print Preview toolbar.
In the Print dialog box that appears, select the page range and number of copies you want to print and then click OK.
Here are some of report examples	
[image: ]
[image: ]

[image: ]

[image: ]
[image: ]
	You are Done!!!

121
SSIGL 21:  Selected Application Software’s
[bookmark: _Toc475647293][bookmark: _Toc531650092]Reference
Eagle Point 2007, User Manual
Hec-Ras River Analysis System, User Manual
Hec-Ras River Analysis System, Hydraulic Reference Manual
Hec-Ras River Analysis System, Application Guide
Zprofile, User Manual
ICT, WAPCOS Irrigation canal long section VB.net program
Shimburit Micro Earth Dam Irrigation Project Headwork Feasibility Study Document
GeoStudio 2007 documentation
Slope Stability: US Army Corps of Engineers, ENGINEERING AND DESIGN
DESIGN OF SMALL DAMS; USBR
General Design and Construction Considerations for Earth and Rock-Fill Dams; US Army Corps of Engineers
Earth Dams and Reservoirs; U.S. Department of Agriculture Soil Conservation Service Engineering Division
Ms-Project 2016 User Manual
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View Clipboard Font 5 Schedlle Tasks Insert Properties diting ~
2015 -
Task Qir4, 2015 Qir1, 2016 Qir2, 2016 Qir3, 2016
Mode  Task Name w | Duration v Start ~ Finish v Predecessors v Nov Dec Jan Feb Mar Apr May Jun Jul Aug Sep.
1 |y Mobilization 7 days ‘Wed 11/11/15 Wed 11/18/15
2 |my Milstone-1 0days Wed 11/18/15 Wed 11/18/15 1 s
3 |wm Access Road Maintenance cutting to an 7 days Thu 11/19/15  Thu 11/26/15 1
average depth of 0.3m, with 6m width or to
remove top soil
4 |wy 12.42 days Fri 1172715 Fri 1211115
5 |wm 0.88 days Fri 112715 Fri 1127115 3
6 |wm 252 days Fri 112715 Tue 12/1115 5
7 |y Cart away surplus excavations 2569 days Tue 127115 Fri12415 6 L
5 |wg 20 cm hard core(wet) 015 days Tue 121115 Tue 121115 6
9 |wm ‘Stone masonry works of mix ratio 1:4. 5.38 days Tue 1211115 Mon 12/7115 6
10 =y ‘5cm Cement screed 1.3 days Tue 1211115 Wed 12/2/15 8
11 [y CIS walling (G-32) 215 days Mon 12/7/15  Wed 12/9/15 9 i%
12 [my CIS roofing (G-32) 149 days Wed 12/9/15  Fri 1271115 11
£ 13 m 4 Fencing (76m)=20x18 4days Fri 112115 Wed 1212115
< u = Excavation by manpower (for 31 poles) .09 days Fri 112715 Fri 112715 5
T 15w Purchasing, transporting, cutting, and 2 days Fri 1127715 Mon 11/30/15 14SS
E ercting of Eucalyptus pole of @10cm at
z ‘each 2.5m length
é 16 |wy Concrete works of mix ratio 1:2:4 0.08 days Mon 11/30/15  Mon 11/30/15 15
17 =y Burbled Wire around the fence for 1.8 days Mon 11/30/15  Wed 12/2/15  16SS
protection
18 |wy Nails ( No 8cm) for fence construction 2 days Mon 11/30/15  Wed 12/2/15  16SS
19 |wy Milestone-2 0 days Fri 121115 Fri 121115 4 & 1211
2 (= ' Headwork (20m span Masonry Broad [61.72 days Mon 1277115 Wed 2117116 [i
Crested Weir)
21 |y 4 Weir body 39.39 days Mon 12/7/15  Fri 1122116 | | —|
22 |wmy Site clearance 6.25 days Mon 12/7/15  Tue 1215115 9 EL
23 |wm Coffer dam for temporary flow diversion 4 days Tue 12/15/15  Sat 12/119/15 22
with sand filled bags(dry time flow is
‘estimated to 343 I/s and river span about
20m
24 |y Excavation of coarse sand for foundation ~ 4.31 days Sat 12/19/15  Thu 12/24115 23
to a depth not exceeding 2m, including
disposal > 50m
25 |wm [Excavation for river training 7.92 days Thu 12/24/15  Sat 1/2/16 24
2 |my Masonry bedded in 1:3 mortar 10.35 days Thu 1212415 Tue 15116 24 =
« Qi y
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2015 -
Task Qu 4, 2015 a1, 2016 a2, 2016 a3, 2016
Mode  Task Name v Duration v Start v Finish v Predecessors v Nov Dec Jan Feb Mar Apr May Jun Jul Aug Sep
1 |y Mobilization 7 days Wed 11/11/15 Wed 11/18/15
2 |my Milestone-1 0days Wed 11118115 Wed 11/18/15 1 % 118
3 |my Access Road Maintenance cutting to an 7 days Thu 11/19/15  Thu 11/26/15 1
‘average depth of 0.3m, with 6m width or to
remove top soil.
4 |wy » Camping & camp facilities 12.42 days Fri 112715 Fri 12111115 —
19wy Milestone-2 0 days Fi124115  Fri12/1115 4 &12m
20 |wm » Headwork (20m span Masonry Broad 61.72 days Mon 127115 Wed 2117/16
Crested Weir)
61 |my Milestone-3 0 days Wed 2117/16  Wed 211716 20 St
62 |mmy > Main Canals 68.78 days Tue 2/9/16 Thu 4/28/16 l—&
70 |my Milestone-4 0 days Thu4/28/16  Thu4/28/16 62 S48
71wy » Secondary Canals (1,2,3,4) 11.2 days Thu 4128116 Wed 511/16. —
78wy Milestone-§ 0 days Wed 5/11/16  Wed 5/1116 71 &5
L 9, » Tertiary canals (1,2) 8.69 days Tue 5316 Fri 5113116 —
< 86 |my Milestone-6 0 days FisM316  Fri51316 79 &513
T o7 m » Turnouts (74 No) 152 days Fri56M6  Tue 524116 —
E % = Milestone-7 0 days Tue 52416 Tue 5/24/16 87 & 524
E 99 |mmy © Flume ( RCC,F1 on Mc, L= 31m) 16.66 days Thu 428116 Wed 5/18/16 |—|l
O 112wy Milestone-8 0 days Wed 5/18/16  Wed 5/18/16 99 &518
113 |y » Night storage 85.23 days Sat4/30116  Mon 8/8/16 [} il
140 [my Milestone-9 0 days Mon 8/8/16  Mon 8/8/16 113 Jes
141 |y » Chutes (2No ) (on Mc L = 400m, on SC2L = 40.5 days Wed 6/1/16  Mon 7/18/16
250m)
146 |y Milestone-10 0 days Mon 7/18/16  Mon 7/18/16 141 S8
147 |y » Division Boxes (6 in Number) 16.46 days Sat6/18116  Fri 718116 —
161 |y Milestone-11 0 days Fri 718116 Fri 718116 147 sus
152 |my » Drainage Culvert on Lined Canal (7 in 21.98 days Tue 621116 Sat 7/16/16
Number)
168 |my Milestone-12 0 days Sat7M6/16  Sat7/16/16 152 &6
159 |y » Box Culverts for Road Cross (8 in Numbers) 17.69 days Sat7/2116  Sat7/23/16 —
165 |my Milestone-13 0 days Sat7/23116  Sat7/23/16 159, Sun -
166 |y » Foot Path/Bed Bar on Lined Canal (2 in 12.39 days Sat7/23116  Sat 8/6/16
Numbers)
172 [my Milestone-14 0 days Sat8/6116  Sat86/16 166 86
173 |y © Bed Bar with Slab (11 in Numbers) 6 days Tue 7126116 Tue 812116 ] ]
gl v« >
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©  Resource Name > Type v Material v Initials v Group v Max. v Std.Rate ~ Ovt.Rate v Cost/Use v Accrue v Base ~ Code ~ WBS ~  Add New Column _~ =
1 Dozer Work DO 1 $2676.00hr  $0.00/r $0.00 Prorated  Standard
2 Loader Work Lo 1 $1,10400hr  $0.00/r $0.00 Prorated  Standard
3 Excavator Work =) 1 $1707.00hr  $0.00/r $0.00 Prorated  Standard
4 Roller Compactor Work RC 1 $68200Mhr  S0.00Mr $0.00 Prorated  Standard
5 Dump Truck Work DT 2 S74000mr  $0.00/hr $0.00 Prorated  Standard
6 Water Truck Work wr 1 $80.00/hr  $0.00/r $0.00 Prorated  Standard
7 Construction Foreman Work CF 2 $28.00hr  $0.00/r $0.00 Prorated  Standard
8 Construction Manager Work oM 1 $38.00/hr  $0.00/r $0.00 Prorated  Standard
9 Site Engineer Work SE 1 $46.00hr  $0.00/r $0.00 Prorated  Standard
10 Mason Work MA 2 $15.00hr  $0.00r $0.00 Prorated  Standard
11 Plasterer Work PL 10 $15.00hr  $0.00r $0.00 Prorated  Standard
2 Chiseler Work CH 4 $15.00hr  $0.00r $0.00 Prorated  Standard
13 Welder Work wL 1 $17.00hr  $0.00r $0.00 Prorated  Standard
Lo Carpenter Work cP 8 $15.00hr  $0.00r $0.00 Prorated  Standard
e Bar Bender Work BB 3 $10.00hr  $0.00/r $0.00 Prorated  Standard
5 16 Daily Laborer Work DL 180 $8.00hr  $0.00/hr $0.00 Prorated  Standard
5}
5
2
3
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December 2015 -
o Nov 15, 15 Nov 22, 15 Nov 29, 15 Dec 6,15 Dec 13,15
© tode - TaskName ~|Duration v Stat - Finish v |Predecesso F S S M T W T F § S M T W T F S § M T W T F S SMTWwWT S S| M |T |\
1 - Mobilization 7 days Wed 11/11/15_ Wed 11/18/15
2 - Milestone-1 0days Wed 11/18/15_Wed 11/18/15 1 % 118
3 ‘q ‘ ‘Access Road Maintenance cutting to an ‘Trhys ‘n-. 11/19/15  Thu 11/26/15 1 [
‘average depth of 0.3m, with 6m width or to
= remove top soil.
£ 4 = '+ Camping & camp facil 12.42 days Fi 112115 Fri 12111715 [
T s - Site clearance 0.83 days Fi 12105 Fi 112115 3
E & - ‘Trench and other excavations 252 days Fi2115  Tue 12115 §
z 7 - Cart away surplus excavations 269 days Tue 12115 Fi12415 6
(O - 20 cm hard core(wet) 0.15 days Tue 12115 Tue 12115 6
9 - ‘Stone masonry works of mix ratio 1:4 5.33 days Tue 124115 Mon 1277115 6
10 - 5cm Cement screed 13 days Tue 121115 Wed 122115 8
1 - CIS walling (G-32) 215 days Mon 1217/15  Wed 129115 9
12 - CIS roofing (6-32) 149 days Wed 12/9/15  Fii 1211115 11
13 - 4 Fencing (76m)=20x18 4days Fri 112715 Wed 1272115
" - Excavation by manpower (for 31 poles) 0.09 davs Fi 12115 Fi 112115 § A hd
gl v« »
Name: | Access Road Maintenance cutting to an avi| Duration: | 7 days 2| effort driven  []Manually Scheduled Previous Next
Start: | Thu 11/19/15 ~|  Finigh: | Thu 11/26/15 v| Tasktype: |Fixed Duration v| 9% Complete: | 0% | =
ID_ Resource Name Work R/D__Leveling Delay Delay Scheduled Start__ Scheduled Finish e
& |Construction Manager s6h od od Thu 11719715, Thu 11726/15)
9 site Engineer s6h od od Thu 11719715, Thu 11726/15)
7 Construction Foreman 1120 od od Thu 11719715, Thu 11726715,
2 | 1 pomer seh od od  Thuti19ns  Thu1126/15)
Q 16 Daily Laborer 336h od: od: Thu 11/19/15' Thu 11/26/15|
]
=
v
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December 2015 -
Tt Nov 29, 15 Dec 6,15 Dec 13,15
Mode + TaskName v Duation v Stat v Finish  + | Resource Names - F|,S S| M T W T F|S s M T W|T F s s M|T
1 [m Mobilization 7days Wed 11/11/15_ Wed 11/18/15 -
2 |my Milestone-1 0days Wed 11/18/15  Wed 11/18/15
3w Access Road Maintenance cuting to an 7days Thu 19/19/45  Thu 11/26/15  Construction Manager(0.1], Construction Manager(0.1],Site Engineer{0.1],Construction Foreman{0.2],Dozer, Daily Laborer(6]
‘average depth of 0.3m, with 6m width or to Site Engineer[0.1],
remove top soil Construction Foreman{0.2], Doze
4 |my 12.42 days Fi 112715 Fri 1211115
5 |my 0.83 days Fi 112715 Fi 1/27/15  Construction Manager(0.01].Site Construction Manager[0.01], Site Engineer{0.01],Construction Foreman[0.2],Daily Laborer{16]
6 |y 252 days Fi 112715 Tue 1211/15  Construction Manager[0.1]Site Construction Manager[0.1],Site Engineer[0.25],Construction Foreman[0.5],Daily Laborer[16]
7wy Cart away surplus excavations 269 days Tue 121115 Fi 12/4/15  Construction Manager(0.1]Site f | Construction Manager(0.1],Site Engineer[0.25],Constfuction Foreman[0.5],Daily Lak
8 |my 20 cm hard core(wet) 0.15 days Tue 121115 Tue 1211/15  Construction Manager{0.1]Site f | Construction Manager[0.1],Site Engineer{0.25],Construction Foreman[0.5]Mason[4],Daily Laborer[16]
9 |my ‘Stone masonry works of mix ratio 1:4 5.33 days Tue 121115 Mon 12/7/15  Construction Manager{0.1]Site | Construction Manager(0.1],Site Engineer{0.25],Constructior
10 |wy 5cm Cement screed 1.3 days Tue 12/116  Wed 12/2/15  Construction Manager[0.1],Site £ an[0.5],Mason[4],Chiseler[4],0
1 |y CIS walling (G-32) 215 days Mon 12/7/15  Wed 12/9/15 _ Construction Manager[0.1]Site Manager{0.1],Site Engineer(0.
12 |my CIS roofing (6-32) 149 days Wed 12/9/15  Fii 121115 Construction Manager[0.1]Site Construction Manager[0.1],Sit
£ 13 m 4 Fencing (76m)=20x18 4days Fri 112715 Wed 1272115
< u = Excavation by manpower (for 31 poles)  0.09 days Fi 112715 Fi 127715 Construction Manager(0.1]Site £ ‘Construction Manager(0.1],Site Engineer{0.25],Construction Foreman[0.5],
G 15 m Purchasing, transporting, cutting, and 2 days Fii11/27/15 Mon 11/30/15  Construction Manager(0.1], Construction Manager[0.1],Site Engineer{0.1],Constiuction Foreman{0.25],Carpenter{4],Daily Laborer[s]
E ercting of Eucalyptus pole of @10cm at Site Engineer[0.1],
3 each 2.5m length Construction Foreman{0.25],Can
S 16 m Concrete works of mix ratio 1:2:4 0.08 days Mon 11/30/15 Mon 11/30/15 _ Construction Manager[0.1]Site | ‘Construction Manager[0.1],Site Engineer{0.25],Construction Foreman[0.5],Mason|Carpenter,Daily Laborer{s]
17 |y Burbled Wire around the fence for 18 days Mon 11730115 Wed 12/2/15
protection
18 |my Nails ( No Bcm) for fence construction 2 days Mon 11730115 Wed 12/2/15
19 |my Milestone-2 0days Fit2M115  Fii 121115 &
20 | 4 Headwork (20m span Masonry Broad 61.72 days NMon 1277115 Wed 2117116 T
Crested Weir)
21wy 4 Weir body 39.39 days WMon 1277115 Fri 1122116 l
2 |m Site clearance 6.25 days Mon 12/7/15  Tue 12115/15  Construction Manager[0.1]Site £ —i
23 | Coffer dam for temporary flow dversion 4 days Tue 12/16/15  Sat 12/19/15  Construction Manager(0.1],
with sand filled bags(cry time flow is Site Engineer(0.25],
estimated to 343 I/s and river span about Construction Foreman,
20m Daily Laborer[40]
2 |my Excavation of coarse sand for foundation 431 days Sat 12119115 Thu12/24/15  Construction Manager(0.1],
t0a depth not exceeding 2m, including Site Engineer(0.25],
disposal > 50m Construction Foreman{0.5],Daily
2 |my Excavation for rver training 7.92 days Thu12/24116  Sat 12116 Construction Manager[0.1]Site £
2 |m Masonry bedded in 1:3 mortar 1035 days Thu 12/24116 Tue 15116 Construction Manager[0.1]Site £ =
gl > >
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of 0.3m, with 6m width or to remove top soil. Site Engineer[0.1],
Construction Foreman{0.2].D1
4 - 4 Camping & camp facil 1242days  Fi 12015 Fri 121115
5 - Site clearance 0.83 days Fi 12105 Fi 112115 3 Construction Manager[0.01].¢ Constfuction Manager[0.01] Site Engineer[0.01],Construction Foreman[0.2],Daily Laborer{16]
6 - ‘Trench and other excavations 252 days Fi2115  Tue 12115 § Construction Manager[0.1.Si Congtruction Manager0.1],Site Engineer{0.25],Construction Foreman[0.5],Daily Laborer[16]
7 - Cart away surplus excavations 269 days Tue 12115 Fi12415 6 Construction Manager[0.1.Si Costruction Manager(0.1],Site Engineer{0.25],Construction Foreman[0.5],Daily Laborer[16]
8 - 20 cm hard core(wet) 0.15 days Tue 12115 Tue 12115 6 Construction Manager[0.1.Si ‘Contruction Manager[0.1],Site Engineer{0.25],Construction Foreman[0.5],Mason[4],Daily Laborer[16]
9 - ‘Stone masonry works of mix ratio 1:4 5.33 days Tue 124115 Mon 1277115 6 Construction Manager[0.1.Si nstruction Manager[0.1], Site Engineer[0.25] Construction Foreman[0.5],Mason{4],Daily Laborer{12]
10 - 5cm Cement screed 13 days Tue 121115 Wed 122115 8 Construction Manager[0.1.Si istruction Manager(0.1],Site Engineer[0.25],Construction Foreman[0.5]Mason[4],Chiseler[4], Daily Labor
1 - CIS walling (G-32) 215 days Mon 1217/15  Wed 129115 9 Construction Manager[0.1.Si nstruction Manager[0.1], Site Engineer{0.25] Carpenter{4],Daily Laborer{16],Construction Foreman|
£ o2 - CIS roofing (6-32) 149 days Wed 12/9/15  Fii 1211115 11 Construction Manager[0.1.Si Construction Manager(0.1],Site Engineer{0.25],Construction Foreman[0.5],Carpenter{4],Daily Laborert
§ 13 - 4 Fencing (76m)=20x18 4days Fri 112715 Wed 1212115
S u - Excavation by manpower (for 31 poles) 0.09 days Fi2105  Fi 112115 § Construction Manager[0.1.5i ‘Constfuction Manager(0.1],Site Engineer{0.25],Construction Foreman[0.5],Daily Laborer{8]
E - Purchasing, transporting, cutting, and ercting of 2 days Fi 112715 Mon 11/30115  14SS Construction Manager{0.1], Congtruction Manager(0.1],Site Engineer{0.1],Construction Foreman0.25],Carpenter{4],Daily Laborer[s]
2 Eucalyptus pole of @10cm at each 2.5m length Site Engineer[0.1],
S Construction Foreman{0.25].(
16 - Concrete works of mix ratio 1:2:4 0.08 days Mon 11/30/15 Mon 11/30/15 15 Construction Manager[0.1].Si ‘Contruction Manager(0.1],Site Engineer{0.25],Construction Foreman[0.5],Mason,Carpenter,Daily Laborer[8
7 - Burbled Wire around the fence for protection 1.8 days Mon 11/30/15  Wed 12/2115  16SS E:
18 - Nails ( No 8cm) for fence construction 2days Mon 11/30/15  Wed 12/2115  16SS
19 - Milestone-2 0days Fi21115  Fi12/115 4 &
2 - 4 Headwork (20m span Masonry Broad Crested ~ 61.72days  Mon 1277/15  Wed 2/17/16 T
Weir)
21 - 4 Weir body 39.39days Mo 127/15 Fri 122116
2 @ - Site clearance 6.25 days Mon 1217/15  Tue 12115115 9 Construction Manager[0.1.5i Construction Manager(0.1],Sit¢ Engineer{0.25],Construction Foreman[0.25],Daily Laborer{40]
2 - Coffer dam for temporary flow diversion with sand 4 days Tue 1216115 Sat 12719115 22 Construction Manager{0.1], Construction Manager(0.1], \eer[0.25],Construction Foreman, Daily Laborer[40]
filed bags(dry time flow is estimated to 343 Vs Site Engineer(0.25],
and river span about 20m Construction Foreman,Daily
2 - Excavation of coarse sand for foundationtoa 431 days Sat 121915 Thu12124/15 23 Construction Manager0.1] Construction Manager(0.1),Site Engineer{0.25],Construction Foreman[0.5],Daily Laborer[40]
depth not exceeding 2m, including disposal > Site Engineer(0.25],
50m Construction Foreman{0.5.D:
2 - Excavation for rver training 7.92 days Thu 122415 Sat 12116 24 Construction Manager(0.1]5i 1] Site Engineer(0.1],Construction Foreman[0.1],Daily Laborer{40]
2 - Masonry bedded in 1:3 mortar 1035 days Thu 122415 Tue 1S/16 24 Construction Manager[0.1.Si =
77 - Plastering in 1-3 mertar 407 davs Mon 11816 Fri 12916 76SS+hdavs  Construction Mananer0 11 Si =
< > >
Ready  # New Tasks : Manually Scheduled B m B B O - 1 +
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o - « Didiga SSIP Construction Time 236.27 days
Schedule
1 - Mobilization 7days
2 - Milestone-1 0days 1’_
3 - Access Road Maintenance cuttingtoan 7 days Construction Manager[0.1],Site Engineer(0.1],Construction Foreman]0.2],Dozer,Daily Laborer{6]
‘average depth of 0.3m, with 6m width or to
remove top soil
4 - 4 Camping & camp fa 12.42 days I
5 - Site clearance 0.83 days ¥ Construgtion Manager[0.01],Site Engineer[0.01],Construction Foreman(0.2],Daily Laborer{16]
6 - ‘Trench and other excavations 252 days Constfuction Manager[0.1],Site Engineer[0.25],Construction Foreman]0.5],Daily Laborer{16]
7 - Cart away surplus excavations 269 days Construction Manager[0.1],Site Engineer[0.25],Construction Foreman]0.5],Daily Laborer{16]
[ - 20 cm hard core(wet) 0.15 days ‘Construction Manager[0.1],Site Engineer(0.25],Construction Foreman[0.5],Mason[4],Daily Laborer[16]
9 - ‘Stone masonry works of mix ratio 14 5.38 days nstruction Manager[0.1], Site Engineer[0.25],Construction Foreman[0.5],Mason[4],Daily Laborer[12]
10 - 5cm Cement screed 13 days nstruction Manager[0.1], Site Engineer[0.25],Construction Foreman[0.5],Mason4],Chiseler[4], Daily Laborer[16]
o1 - CIS walling (G-32) 215 days nstruction Manager(0.1], Site Engineer[0.25],Carpenter[4], Daily Laborer{16],Construction Foreman[0.5]
T 2 - CIS roofing (6-32) 149 days Construction Manager[0.1],Site Engineer(0.25],Construction Foreman[0.5],Carpenter[4],Daily Laborer[16]
[CAE) - 4 Fencing (76m)=20x18 4days m
E u - Excavation by manpower (for 31 poles) 0.09 days TConstrugtion Manager{0.1], Site Engineer{0.25],Construction Foreman0.5],Daily Laborer[8]
Z 5 - Purchasing, transporting, cutting, and 2 days Constiuction Manager[0.1],Site Engineer[0.1],Construction Foreman(0.25], Carpenter[4], Daily Laborer{s]
[} ercting of Eucalyptus pole of @10cm
at each 2.5m length
16 - Concrete works of mix ratio 124 0.08 days I Constiuction Manager[0.1], Site Engineer[0.25],Construction Foreman[0.5], Mason,Carpenter,Daily Laborer{s]
17 - Burbled Wire around the fence for 1.8 days b
protection
(R Nails ( No 8cm) for fence construction 2 days ba
19 - Milestone-2 0 days &
2 - 4 Headwork (20m span Masonry Broad 6172 days
Crested Weir)
21 - 4 Weir body 39.39 days 1
2 @ - Site clearance 6.25 days Construction Manager[0.1],Site Engineet0.25],Construction Foreman[0.25],Daily Laborer[40]
2 - Coffer dam for temporary flow diversion 4 days Construction Manager[0.1],Site Enginger[0.25],Construction Foreman,Daily Laborer{40]
with sand filled bags(cry time flow is
estimated to 343 I/s and river span
about 20m
2 - Excavation of coarse sand for 431 days Construction Manager[0.1],Site Engineer[0.25],Construction Foreman]0.5],Daily Laborer{40]

foundation to a depth not exceeding
2m, including disposal > 50m
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